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Important
The following functions are for reference only. Some series products may not support all the functions
listed below.

Cybersecurity Recommendations

1. Change Passwords and Use Strong Passwords

The number one reason systems get fAhackedo is due t
recommended to change default passwords immediately and choose a strong password whenever

possible. A strong password should be made up of at least 8 characters and a combination of special

characters, numbers, and upper and lower case letters.

2. Update Firmware
As is standard procedure in the tech-industry, we recommend keeping NVR, DVR, and IP camera
firmware up-to-date to ensure the system is current with the latest security patches and fixes.

ANi ce to haved recommendations to i mprove your netyv

1. Change Passwords Regularly
Regularly change the credentials to your devices to help ensure that only authorized users are able to
access the system.

2. Change Default HTTP and TCP Ports:
0 Change default HTTP and TCP ports for systems. TFh
to view video feeds remotely.

0 These ports can be changed t &5535nAvoidingthe defdult pptsmb er s
reduces the risk of outsiders being able to guess which ports you are using.

3. Enable HTTPS/SSL.:
Set up an SSL Certificate to enable HTTPS. This will encrypt all communication between your devices
and recorder.

4. Enable IP Filter:
Enabling your IP filter will prevent everyone, except those with specified IP addresses, from accessing

the system.

5. Change ONVIF Password:
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On ol der I P Camera firmware, the ONVIF password doe
credentials. You wil/ need t o eilatdstgavisianprananuadly t he ¢ an
change the ONVIF password.

6. Forward Only Ports You Need:

6 Only forward the HTTP and TCP ports that you need
to the device. Do not DMZ the device's IP address.

0 You do teoforwardmre eadts for individual cameras if they are all connected to a recorder on

site; just the NVR is needed.

7. Disable Auto-Login on SmartPSS:

Those using SmartPSS to view their system and on a computer that is used by multiple people should
disable auto-login. This adds a layer of security to prevent users without the appropriate credentials
from accessing the system.

8. Use a Different Username and Password for SmartPSS:

In the event that your social media, bank, email, etc. account is compromised, you would not want
someone collecting those passwords and trying them out on your video surveillance system. Using a
different username and password for your security system will make it more difficult for someone to
guess their way into your system.

9. Limit Features of Guest Accounts:
If your system is set up for multiple users, ensure that each user only has rights to features and
functions they need to use to perform their job.

10. UPnP:

0 UPNnP wildl automatically try to forward ports in 'y
thing. However, if your system automatically forwards the ports and you leave the credentials defaulted,

you may end up with unwanted visitors.

0 | f aypually formarded the HTTP and TCP ports in your router/modem, this feature should be

turned off regardless. Disabling UPnP is recommended when the function is not used in real

applications.

11. SNMP:
Disable SNMP if you are not using it. If you are using SNMP, you should do so only temporarily, for
tracing and testing purposes only.

Vi
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12. Multicast:
Multicast is used to share video streams between two recorders. Currently there are no known issues
involving Multicast, but if you are not using this feature, deactivation can enhance your network security.

13. Check the Log:

If you suspect that someone has gained unauthorized access to your system, you can check the system
log. The system log will show you which IP addresses were used to login to your system and what was
accessed.

14. Physically Lock Down the Device:
Ideally, you want to prevent any unauthorized physical access to your system. The best way to achieve
this is to install the recorder in a lockbox, locking server rack, or in a room that is behind a lock and key.

15. Connect IP Cameras to the PoE Ports on the Back of an NVR:
Cameras connected to the PoE ports on the back of an NVR are isolated from the outside world and
cannot be accessed directly.

16. Isolate NVR and IP Camera Network

The network your NVR and IP camera resides on should not be the same network as your public
computer network. This will prevent any visitors or unwanted guests from getting access to the same
network the security system needs in order to function properly.

Electrical safety

All installation and operation should conform to your local electrical safety codes.

The power source shall conform to the requirement of the Safety Extra Low Voltage (SELV)
standard, and supply power with voltage rated by DC 12 V or AC 24 V according to the Limited
power Source requirement of IEC60950-1. Please note that the power supply requirement is
subject to the device label.

Make sure the power supply is correct before operating the device.

A readily accessible disconnect device shall be incorporated in the building installation wiring
Prevent the power cable from being trampled or pressed, especially the plug, power socket and the
junction extruded from the device.

We assume no liability or responsibility for all the fires or electrical shock caused by improper
handling or installation.

B

B

Environment

Vil
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Do not aim the device at strong light to focus, such as lamp light and sun light, otherwise it might
cause over brightness or light marks, which are not the device malfunction, and affect the longevity
of Charge Coupled Device (CCD) or Complementary Metal-Oxide Semiconductor (CMOS).
Do not place the device in a damp or dusty environment, extremely hot or cold temperatures, or the
locations with strong electromagnetic radiation or unstable lighting.
Keep the camera away from water or other liquid to avoid damages to the internal components.
Keep the indoor device away from rain or damp to avoid fire or lightning.
Keep sound ventilation to avoid heat accumulation.
Transport, use and store the device within the range of allowed humidity and temperature.
Heavy stress, violent vibration or water splash are not allowed during transportation, storage and
installation.
Pack the device with standard factory packaging or the equivalent material when transporting the
device.

Privacy Protection Notice

As the device user or data controller, you might collect personal data of others' such as face,
fingerprints, car plate number, Email address, phone number, GPS and so on. You need to be in
compliance wittthe local privacy protection laws and regulations to protect the legitimate rights
and interests of other people by implementing measures include but not limited to: providing clear
and visible identification to inform data subject the existence of dlave¢ area and providing

related contact.

About the Manual

The Manual is for reference only. If there is inconsistency between the Manual and the actual product, the

actual product shall govern.

We are not liable for any loss caused by the operationdahadt comply with the Manual.

The Manual would be updated according to the latest laws and regulations of related regions. For detailed

information, see the paper User's Manual,-RDM, QR code or our official website. If there is

inconsistency betweeraper User's Manual and the electronic version, the electronic version shall prevail.

All the designs and software are subject to change without prior written notice. The product updates might

cause some differences between the actual product and the MRleaak contact the customer service for

the latest program and supplementary documentation.

There still might be deviation in technical data, functions and operations description, or errors in print. If

there is any doubt or dispute, please refer tdinal explanation.

Upgrade the reader software or try other mainstream reader software if the Guide (in PDF format) cannot be

opened.

All trademarks, registered trademarks and the company names in the Manual are the properties of their
Vil
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respective owners.

Please visit our website, contact the supplier or customer service if there is any problem occurred when using
the device.

If there is any uncertainty or controversy, please refer to our final explanation


http://www.affordablelaundry.com/all-trademarks-and-registered-trademarks-are-the-property-of-their-respective-owners
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1 Product Overview

The common networking mode for IPC is to connect IPC to PC via switch or router. The common
network mode is shown in Figure 1-1.

Cable
Switch or Router

IPC

Figure 1-1

Before you have access to network camera via the Internet, you need to acquire its IP address. Users
can search IP address of network camera via Quick Config Tool.
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2 Initial Config

In this chapter it is to introduce the device initial config operation, which includes device initialization,
login device, log out WEB interface and password reset.

2.1 Device Initialization

It needs to implement device initialization when you use the device for the first time. Here it is to take
WEB operation as an example to introduce device initialization. You can also initialize device via Quick
Config Tool, NVR and platform etc.

Note

In order to guarantee device safety, please keep admin login password properly after device
initialization, and modify the password regularly.

Step 1

Open IE browser, input camera IP address in the address bar and click Enter.

The system will display the interface of Device Initialization after it is connected successfully, which is
shown in Figure 2-1.

Note

The default IP address is 192.168.1.108.

Device Initialization

Username admin

Password The minimum pass phrase length is 8 characters

Confirm Password

Use a password that has 8 to 32 characters, it can be a combination of letter(s),
number(s) and symbol(s) with at least two kinds of them.(please do notuse

special symbols like"™;: &)

[v] Email Address
To reset password, please input properly or update in time.

Save

Figure 2-1

Step 2
It is to set admin login password, please refer to Table 2-1 for more details.
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Parameter Note
User name The default user name is admin
Password The password ranges from 8 to 32 digitals. It can contain letters, numbers
Confirm and speci al c har afc"tde,ris; 0Of, efix col, Uid& on) g
assword contain at least two categories. Usually we recommend the strong
P password.
Input an email address for reset password purpose. In case you forgot
Email password in the future, input the security code you got on the assigned
email to reset the password of admin.
Table 2-1
Step 3
Click Save.

The system will display the interface of End-User License Agreement, which is shown in Figure 2-2.

End-User License Agreement

>

Zhejiang Dahua Technologies Co. Ltd. Software End User License Agreement

1. NOTICE

IMPORTANT NOTICE. PLEASE READ CAREFULLY: This Zhejiang Dahua Technology Co. LTD (Dahua) License Agreement
(‘Agreement) sets forth the terms and conditions under which You are licensed to use the Software. By installing, copying,
downloading the Sofiware or using the same by any other means, you are deemed to have accepted this Agreement. If you do not
agree with itin whole orin part, you do not have the right to use this Software, in which case you should immediately stop installing,

L]

copying the Software or using the same by any other means.

2. DEFINITIONS

‘Software’ means information management program(s) or supporting document(s) consisting of several modules or functions.
Supporting document(s) includes all or part of the source codes and object codes of the Software, as well as the images,
photographs, icons, animations, audio, video, music, words and codes incorporated therein; it also includes all relevant paper or
electronic information and technical documentation which describe the functions, characteristics, contents, quality, tests, customer

manuals useranrepments ste CSoftware Product ar 'Saftware’

[7] I have read and agree to all terms

Figure 2-2

Step 4
Select | have read and agree to all terms and click Next.
The system will display the interface of P2P, which is shown in Figure 2-3.
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P2P

P2P
To assist you in remotely managing your device, the P2P will be enabled. After enabling P2P and connecting to Internet, we need to
collect IP address, MAC address, device name, device SN, etc. All collected info is used only for the purpose of remote access. If you
don't agree to enable P2P function, please deselect the check box.

Figure 2-3

Step 5
Select P2P according to actual needs and realize P2P registration for device, click next. The system will
display the interface of Online Upgrade, which is shown in Figure 2-4

Online Upgrade

[V] Auto-check for updates

Notify automatically when updates available. The system checks for updates every day.

Online Upgrade is a service that provides you with firmware updates by cloud. This service will collect device information in order to
inform you about available firmware updates. Such information may include your device name, firmware version and device
identification numbers. Such information is processed for the sole purpose of informing you about firmware updates.

Save

Figure 2-4

Step 6
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It is to set upgrade method according to the actual requirements.
Select Auto-check for upgrade and the system will check once daily automatically when there is system
upgrade prompt.
Note
After |l ogin, you can make setting in 6Setup > Syste

Step 7
Click Save and device initialization is completed.

2.2 Login and Logout

Here it is to introduce device login and WEB interface logout via browser, it is to take IE Explorer 8 as
an example to make introduction.
2.2.1 Log in WEB Interface
Users can make operations such as live, playback and config upon the device after logging in device
WEB interface via browser.
Note
It can log in WEB interface after device initialization is completed.
It will prompt to install plug-in when logging in the system for the first time, please download and
install plug-in according to prompt.
Step 1
Open IE browser, input camera IP address in the address bar and click Enter button.
The system will display the Login interface after it is successfully connected, which is shown in Figure
2-5.

Username:

Password: . Forgot password?

Login Cancel
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Figure 2-5

Step 2

Input the password of admin user.

Step 3

Click Login.

It will display the Live interface after it logged in successfully, which is shown in Figure 2-6.

Note

Different devices have different functions with different interface display; please refer to the actual
interface for more detalils.

@lhua IEEZSR SN (7T S ST AT

ol subsveam | swsteame EEESRTCP <= THOHE SR XG;

Figure 2-6

2.2.2 Logout

Click Logout and return to WEB login interface. After logging in the device WEB, the system will
hibernate automatically if it fails to operate the device for a period of time. It can recover to normal
working status quickly after entering password.

2.3 Reset Password

Users can reset password via reserved email when you forget the password of admin user.
Step 1
Open IE browser, input camera IP address in the address bar and click Enter button.
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The system will display the Login interface after it is successfully connected, which is shown in Figure
2-7.

Username:

Password; | Forgot password?

Login Cancel

Figure 2-7

Step 2
Click Forgot password?
The system will display the interface of Reset Password, which is shown in Figure 2-8.

Reset the password(1/2)
SN: 2C04ABIYAZ00019
QR code:
Note(For admin only):
Option 1. Please download Easy4ip and then from
Me-Settings-Reset device password, scan the left
QR code.
Option 2. Please use an APP to scan the left QR
code to get special strings. And then send the
strings to support_rpwd@aglobal.dahuatech.com.
The security code will be delivered to 1***@gg.com
Security code:
I Cancel I I Next I
Figure 2-8

Step 3
Reset login password.
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Scan the QR code according to the interface prompt and acquire security code, then input the security
code which is received via your reserved email.
Caution
Please use the security code to reset the password within 24 hours after you received the security
code via your reserved email. Otherwise the security code will be invalid.
If you fail to use security code for twice continuously, then the system will prompt that it fails to
acquire security code for the third time. It needs hardware to restore device default setting and
acquire security code again or wait for 24 hours and acquire it again if it needs to use the device
normally.

B

Step 4
Click next.
The system will display the interface where you can set the new password, which is shown in Figure 2-9.

Reset the password(2/2)

Username admin

Password

Use a password that has 8 to 32 characters, it
can be a combination of letter(s), number(s) and
symbol(s) with at least two kinds of them.
(please do not use special symbols like*™;: &)

Confirm Password

| Cancel I I Save l

Figure 2-9

Step 5

Reset Password and Confirm Password.

The password ranges from 8 to 32 digitals. It can contain letters, numbers and special characters
(excluding A'"o,An"o,n; o0, fA: 0, A&o) . The password shal
the strong password.

Step 6

Click Save and complete password reset.

The system will display the Login interface.
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3 Live

After you logged in, you can see the live monitor window. See Figure 3-1.

@lhua

4 W oo% 5 & %o & ©

Figure 3-1

There are four sections:
Section 1: Encode setup bar
Section 2: System menu
Section 3: Window function option bar
Section 4: Window adjust bar

3.1 Encode Setup

Note: Some serisabsstredo 6t support
The encode setup interface is shown as in Figure 3-2.

Sub Stream 1 Sub Stream 2 Eeddtdesd m

Figure 3-2

Please refer to the following sheet for detailed information.
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Parameter

Function

Main stream

Click it to enable main stream video monitoring and click again
to disable it. Generally for storage and monitor.

Sub Stream 1

Click it to enable Sub Streaml video monitoring and click again
to disable it. When network bandwidth is insufficient, it
substitutes main stream for monitoring.

Sub Stream 2

Click it to enable Sub Stream 2 video monitoring and click again
to disable it. When network bandwidth is insufficient, it
substitutes main stream for monitoring.

Protocol

You can select stream media protocol from the dropdown list.
There are three options: TCP/UDP/Multicast

3.2 System Menu

System menu is shown as in Figure 3-3.

Please refer to chapter 2 Live, chapter 3 PTZ, chapter 4 Playback, chapter 5 Setup, chapter 6 Alarm,

chapter 7 Log out for detailed information.

r Live T PTZ Flalbank T S:Etua T Alarm Luﬁnut ]

Figure 3-3

3.3 Video Window Function Option

The interface is shown as below. See Figure 3-4.

Please refer to the following

Figure 3-4

sheet for detailed information.

SN Parameter Function

1 Relay-out

It shows if there is any alarm output, status description is as
follows:

Red: means there is alarm output.

Grey: means alarm is over.
Click on the button to force alarm to be on or off.

1C
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2 Digital . When the video is in the original status, click it you can
Zoom select any zone to zoom in. In the non-original status,
you can drag the zoom-in zone in specified range. Right
click mouse to restore previous status.
,  Click it; you can use the middle button of the mouse to
zoom in/out the video size.
3 Snapshot Click on the button to snapshot, save picture to path in Ch
5.1.2.5.
4 Triple Click it to take snapshot upon the video at the frequency of
Snapshot one picture per second. All images are saved to path in Ch
5.1.2.5.
5 Record Click it to record the video. All videos are saved to path in
Chapter 5.1.2.5.
6 Easy focus | Click it, you can see there are two parameters on the preview
video' AF Peak and AF Max.
AF Peak: It is to display the video definition during the focus
process.
AF Max: It is the most suitable value for the video definition.
The close the AF Peak and AF Max is, the better the focus
effect is.
7 Audio Turn on or off audio when you are monitoring.
8 Talk Click it to start or end bidirectional talk.
9 Help Click it to open help file.

3.4 Video Window Setup

The interface is shown as in Figure 3-5.

7 —
& 100% 53 o it O

ONONONONORONONO)

Figure 3-5

3.4.1 Image Adjustment
See Figure 3-6 for image adjustment.

11
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Image Adjustment

Figure 3-6

Click this button to display/hide image control interface. Click it to open picture setup interface. This
interface is on the top right pane.
Please refer to the following sheet for detailed information.

Parameter Function

Video It is to adjust monitor video Note:

setup brightness. All the operations here apply
to WEB end only.

Please go to Setup-

5

m It is to adjust monitor video

contrasiness. >Camera->Conditions to
a It is to adjust monitor video adjust corresponding items.
hue.

E It is to adjust monitor video
saturation.

Reset | Restore brightness,
contrastness saturation and
hue to system default setup.

3.4.2 Original Size
Click this button to go to original size. It is to display the actual size of the video stream. It depends on
the resolution of the bit stream.

3.4.3 Full Screen
Click it to go to full-screen mode. Double click the mouse or click the Esc button to exit the full screen.

12
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3.4.4 Width and Height Ratio
Click it to restore original ratio or suitable window.

3.4.5 Fluency Adjustment

There are three levels of fluency for you to select (Realtime, Normal, and Fluency). The default is

normal.

3.4.6 Rules Info

Click the button, preview image will display intelligent rules after enabling; itisfenabled by def aul t
3.4.7 Zoom and Focus

Click this button and the focus zooming interface appears on the right of preview interface, as shown in

Figure 2-7, click left mouse button to adjust focus zooming configuration.

Note:
¥ The product series which support motorized zoom, synchronous focus and back focus have this
button.

¥  Auto-focus after zoom and focus adjustment.
3.4.8 Fisheye/Trigger Track
Click the button, installation mode and display mode interface will show up on the right of the preview
interface, see Figure 3-7 and Figure 3-8, and single click to switch different installation modes and
display modes for fisheye, or switch different display modes for trigger track, it is enabled by default.
Note:
It is only supported by some models.

Zoom and Focus

Zoom Speed Ej

Restore All
Refresh

Regional Focus

Figure 3-7
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Parameter | Function

Zoom Adjustthe focall engt h of the |l ens by -0butkbng. o
The speed is used to adjust the length of one step during single click.

FocUs Adjust the sharpness of the df@nsulty omlsi.
Step length is used to adjust the length of one step with one click.
Click to adjust the image definition automatically.

Auto- )
Note:

focus
Other lens operations are not allowed during the process of auto-focus.
Reset the lens to zero position to eliminate the accumulative error of lens.

Reset All | VO _ _ ) _
Please reset when the image adjustment is not clear or operating zoom focus many
times.

Refresh Synchronize the location of drag slider of lens and zoom focus after hardware zoom
focusing.

Regional | Click it and use the mouse to select a zone, then the device can auto focus within the

Focus specific region.

o

In-ceiling Mount Wall Mount Ground Mount

Installation Mode

VoA .
oL Fl | é

Installation Mode

Installation Mode
A

. -p?

#a #a

Display Mode Display Mode

Figure 3-8
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parameter

Note

Installation Mode

Three modes which are ceiling mount, wall mount and ground mount.

Display Mode

It represents the display mode of the current image (default supports original
image mode), the display modes may be different according to different
installation modes. It is shown as follows:

Ceiling: 1P+1a 2Pa 1+23a 1+33a 1+4a 1P+6a 1+8A
Wall: 1Pa 1P+33 1P+4a 1P+8A
Ground: 1P+13 2Pa 1+3a 1+43a 1P+6a 1+8A

Note:

The default displays original image mode when switching installation mode.

In-ceiling/Wall/Ground

O

image

Original

It menas the original image without de-warpping

In-ceiling/Ground

—1p+1

360°expanded rectangular panorama + independent
sub image, the sub image and the subbox in the
expanded rectangular panorama support zoom and
movement, for the expanded rectangular panorama
also supports left and right starting point movement.

i

2P

Two related 180° expanded rectangular pictures, two
subwindows form 360° panorama anytime, which is
al so call ed Adual pano
rectangular pictures both support left and right
movement starting point, which are also linked by
eachother.

(o)
[l

1+2

Original image + 2 independent sub images, both the
sub image and the subbox in the original image
support zoom and movement. The original image also
supports changing starting point by rotation (no such
display mode for ground installation).

3]

Original image + 2 independent sub images, both the
sub image and the subbox in the original image
support zoom and movement. The original image also
supports changing starting point by rotation

= 1+4

Original image + 4 independent sub images, both the
sub image and the subbox in the original image
support zoom and movement. The original image also
supports changing starting point by rotation

—1P+6

360&xpanded rectangular panorama +6 independent
sub image, both the sub image and the subbox in the
expanded rectangular panorama support zoom and
movement, for the expanded rectangular panorama
also supports left and right starting point movement.

15
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parameter Note
Original image + 8 independent sub images, both the
Q sub image and the subbox in the original image
I support zoom and movement. The original image also

supports changing starting point by rotation

From left to right 180° expanded rectangular
panorama, which supports up and down movement
1P and changes vertical angle of view.

Dol

180° expanded rectangular panorama+3 independent
sub images, both the sub images and the sub box in
the expanded rectangular panorama support zoom
1P+3 and movement, expanded rectangular panorama
supports up and down movement and changes vertical
angle of view.
180°expanded rectangular panorama+4 independent
sub images, both the sub images and the sub box in
IEEE the expanded rectangular panorama support zoom
1p+4 | @nd movement, expanded rectangular panorama
supports up and down movement and changes vertical
angle of view.
180°expanded rectangular panorama+8 independent
sub images, both the sub images and the sub box in
the expanded rectangular panorama support zoom
1P+8 and movement, expanded rectangular panorama
supports up and down movement and changes vertical
angle of view.

X

Wall

| B

Display Mode

Al 5
.......II'

Figure 3-9

Enable the trigger track on the interface of tripwire or intrusion, and draw the rule of tripwire or intrusion,

the scene of trigger track window will change according to the moving object when it triggers rule alarm

until the moving object disappears from the view range of the camera. P| ease r e41¢30 f @ri5.
more details about the rules drawing and parameter config of tripwire and intrusion.

Trigger track includes three modes which are 1P, 1P+3 and 1P+5.

E 1P: Original picture

16
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. 1P+3: Original picture and three trigger track windows, it can adjust the location and size of

three trigger track windows on the original picture.

| I 1 1p+5: Original picture and five trigger track windows, it can adjust the location and size of

five trigger track windows on the original picture.
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4 PTZ Control

Here you can view direction keys, speed, zoom, focus, iris, preset, tour, scan, pattern, aux on, off and
PTZ setup button.

Note

Before PTZ operation, please make sure you have properly set PTZ protocol. (Please refer to Ch 5.5.3).
Currently only IPC-HFXXXX series and i PT series products can support PTZ function.

Parameter Note

L PTZ supports eight directions: left/right/up/down/upper left/upper right/bottom
PTZ direction left/bottom right.

It controls rotation speed. The longer the step length, the higher the speed.
Step length control PTZ, zoom, focus and iris.

Use mouse to draw a box in monitoring video, PTZ will rotate and focus to
Quick Position | Quickly positioning.

Speed

@
000
060
000
speed(1-2). [HET
© 0
© 0
-0

PTZ Settings
oo ]

Figure 4-1
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000
0®o
00O

speed(1-5): [jE

© 0

© O
© -0

PTZ Settings

Figure 4-2

PTZ setting interface is shown as in Figure 4-3.
Here you can set scan, preset, tour, pattern, assistant function and light and wiper plus view coordinate.

PTZ Settings

Figure 4-3

4.1 Scan

Scan interface is shown in Figure 4-4.
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PTZ Settings

P Start W Stop

Set Left Set Right

Figure 4-4

Steps to scan are:

Set Left Set Right icon.

Step 1. Click on Set button, display

Step 2. Move via direction key to select left, click on Set Left to set left border of camera
Step 3. Move via direction key to select right, click on Set Right to set right border of camera.
Step 4. Complete scan path setup.

4.2 Preset

Preset interface is shown in Figure 4-5.
PTZ Settings

Preset

Steps to preset are:

Step 1. In preset box, input preset value.

Step 2. Click on Go to, camera rotates to preset position.

Step 3. Use direction key to rotate camera, and in preset box input preset value.
Step 4. Click on Add to add a preset. Range of preset relates to PTZ protocol.

4.3 Tour
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Tour interface is shown in Figure 4-6.

PTZ Settings

P Start W Stop

Figure 4-6

Steps to tour are:

Step 1. In tour box, input tour path value.

Step 2. Click on Add. Range of tour relates to PTZ protocol.

Step 3. In preset box, input preset value.

Step 4. Click on Add as to add a preset in this tour. If click on Del, it deletes this preset in tour.
Note:

You can add more than one preset here, or delete more than one preset.

4.4 Pattern

Pattern interface is shown in Figure 4-7.

PTZ Settings

5
EZIETR

Figure 4-7
Steps to set pattern are shown as follows:
Step 1
l nput pattern serial number value in the box, <c¢click
Step 2
Cli®tkamt RecO to i mplement a series of operations s
Step 3
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Click AStop Recd to complete the setting
Step 4

Click AStart o amadcordirg towhe patternpdthawhith has deaen see t
the pattern ends.

4.5 Assistant

Assistant interface is shown in Figure 4-8.

PTZ Settings

Assistant

Aux On Alx Off

Figure 4-8

Steps to assistant are:

Step 1. In assistant box input assistant value.

Step 2. Click on Aux On to turn on aux function.
Click on Aux off to turn off aux function.

4.6 Light/Wiper

Light wiper interface is shown in Figure 4-9.

PTZ Settings

Light Wiper -

Enable Disable

Figure 4-9

Steps to light wiper are:
Click on Enable to enable light wiper function.
Click on Disable to disable light wiper function.

of

a patte
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5 Playback

Web client playback supports video playback and picture playback.
Note:
Before playback, user shall set storage management as in Ch. 5.4.

5.1 Playback

The playback interface is shown as in Figure 5-1.

X1 1 6

SR SD Card [~

e < BT

Sun Mon Tue Wed Thu Fri Sat
1
213456 7]8

9 10 11 12 13 14 15

1617 18 19 20 21 22 EEE 2

2324125126 |27 28| 29

a0 [31]

1 00000 O CEZEESTETD 3

i 4
Stop Record Type M Al [ General m [ Moton M [ Alam Manual B [CETH ICI

Figure 5-1

There are four sections:

Section 1: Function of play
Section 2: Playback file
Section 3: Play time cut
Section 4: Record type
Section 5: Progress bar
Section 6: Assistant function
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5.1.1 Function of Play
The function of play is shown as in Figure 5-2 and Figure 5-3.

00000 O =0

O @ 6@ @ 6 ® @ @-1

Figure 5-2

00000 O =0

© e 6 e 6 ® O &2

Figure 5-3
Parameter Function
When you see this button, it means pause or not played record. Click on this
Play .
button, switch to normal play status.
Stop Click this button to stop playing.
Click on this button to go to next frame.
Play by frame Note:
You shall pause record when you use this function.
Slow Click on this button to play slowly.
Quick Click on this button to play quickly.
. When this button displays, it means audio is silent. Click on this button to
Silent .
switch back to normal.
Volume Click on left mouse to adjust volume.
-1 Fisheve Click this button and fisheye device can adjust display mode according to
B y different installation mode during the process of playback.
Click the button and it will playback and display intelligent rules and object
- -2 Rule Info detection box if the video is equipped with intelligent rule info after the
function is enabled, it is off by default.
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5.1.2 Playback File
In calendar, blue date represents data currently has video record or snapshot. See Figure 5-4.

Data Src  RIEEET) 7
< 2013 I8

Sun Mon Tue Wed Thu Fri Sat

Parameter Function

Select Adavo, as video playback.

File Type
yp Select Ajpgd as picture playback.

Data Source Default is SD card.

Step 1. Click on data in blue, time axis displays record file progress bar in color. While, green represents
normal record, yellow represents motion detect record, red represents alarm record, and blue
represents manual record.

Step 2. Click on certain time on progress bar, playback starts from this time. See Figure 5-5.

Figure 5-5

Step 3. Click on file list = , select date file will be displayed in list.

Step 4. Double click on file in list, playback this file and display file size, start time and end time.
See Figure 5-6.
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00 : 00 : 00 - 23 : 59 : 59 jfe}

Download Format @ dav © mp4

Start Time  File Type
154939 H @
15:50:07
15:54:38
16:25:13
16:31:35
16:32:06
16:45:58
16:54:00

OCO0O00O0000

17:00:54

<171 » » KN D
Begin Time:
End Time:

File Size:

Parameter Function

BSearch It means records within searched start time and end time on the date.
Download .

Format There are two formats: dav, mp4.
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Parameter Function

m . click the download button and download file to path in Ch. 5.1.2.5.
Download System does not support download and playback at the same time.

rs

Back Click on back button to go to calendar interface.

5.1.3 Playback Cut

Note:

Playback cut function will automatically pause playing record as playback cut and playback cannot be at
the same time.

Step 1. Click on start time to cut on time axis. This time must be within progress bar range.

—_—

Step 2. Move mouse to cut icon gﬁ . You will be ask to select start time. Click on cur icon 5‘5 as

finish cutting.

Step 3. Click on playback cut end time on time axis. This time must be within progress bar range.
— —

Step 4. Move mouse to cut icon-& you will be asked to select end time. Click on cut icon .& as
finish cutting.
Step 5. Click on Save button to save file cut to path in Ch 5.1.2.5. See Figure 5-7.

00:00:00-00:00:00 B

Figure 5-7

5.1.4 Record Type
After checking record file type, only selected file will be displayed in progress bar and file list. Users can

also select the record type to be displayed via the dropdown box which is above the file list. See Figure
5-8.

Record Type [ Al [ General [ Motion @ & Alarm & Manual W

Figure 5-8

5.1.5 Progress Bar
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O zhr O nr | O 30min

Figure 5-9

Parameter Function

(O z4hr 24 hours Click on it, means video in past 24 hours.

©zhr |, hours Click on it, means video in past 2 hours.
Oinr |, hour Click on it, means video in past 1 hour.
®:z0min 30 min Click on it, means video in past 30 min.

5.1.6 Assistant Function
Video playback assistant function is shown in Figure 5-10.

Figure 5-10

Parameter Function

Digital Zoom restore its original size.

Click on it, video in playback status if is in original size, user can
zoom in any area, If it is not in its original size, Right mouse click to

Click on this button, you can scroll to zoom in.

Snapshot will be saved to path in Ch. 5.1.2.5.

E] Click on this button, you can snapshot video under playback status.
Snapshot

5.2 Picture Playback

Web client picture playback interface has the following three functions:

Parameter Function

1 Play function bar
2 Playback file bar
3 Snapshot type bar
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See Figure 5-11.

@Jhua

@

FileType |1 =
Data Src SD Card

e < T

Sun Mon Tue Wed Thu Fri Sat
1 213J4)5])6])7
8910111213} 14
15| 16| 17 (48 8 |20} [23]
22 12342412526 | 27 | 28

29 130 | 31

[>)

Snapshot Type All General W Event M Alarm

Figure 5-11

5.2.1 Play

oo

Figure 5-12

Default icon is E and it means pause or not played picture. Click on play button to switch to

normal play status. lcon become m

Click on it to pause.
5.2.2 Playback File
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< 2013 S

Sun Mon Tue Wed Thu Fri Sat

Figure 5-13

Step 1. Click on file list = , select snapshot file of the date.

Step 2. Double click on file in list, to play this snapshot.

Parameter

Function

n Search

It means all snapshot files within the start time and end time of selected date.
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Parameter Function
m Click the download button to open snapshot file or directly download to local
Download according to the browser types.

& Back Click the back button to return to calendar interface and re-select time.

00 : 00 : 00 - 23 : 59 : 59 jfe}

Start Time  File Type
13:23:16 " O
13:24:55
13:25:09
13:25119
13:25:29
13:25:40
13:25:50
13:26:09
13:26:19
13:27:41
13:27:51
13:28:01

=
9

&
I (clcReNeNeNelelleRe e

M <€1/1p P

Figure 5-14
5.2.3 Snapshot Type
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After checking snapshot file type, in file list only display file of selected type. Users can also select the
snapshot type to be displayed via the dropdown box above the file list. See Figure 5-15.

Snapshot Type All General Event W Alarm

Figure 5-15
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6 Setup

Web client setup support camera, network, time, storage, system and system info view.

6.1 Camera

The camera setting includes conditions, profile management, zoom and focus.

6.1.1 Conditions

Note:

The camera parameter may be different according to different models, please refer to the actual product

for more details.

6.1.1.1 Picture

Note:

The device which supports true WDR fails to support long exposure when true WDR is enabled.

Step 1

Select ASetup > Camera > Conditions > Picturedo and

shown in Figure 6-1.
aJhua

- TECHNOLOGY

Conditions Profile Management§ Zoom and Focus

Profile Day
> Video

> Audio . Style ' Standard |ZI
Network == TECEES : 3 ~ » Expostire Brightness (=] 50
Event : i — - (ZEE A Contrast (=] 50
Storage . ZUE Saturation (=]

System » Day & Night

: g Sharpness (=]
Information 4 » IR Light

OO 000
[
8

Gamma (=]

Mirror ©) ON @ OFF

Flip | 0° E

Default

Refresh I \

Figure 6-1
Step 2
Set picture parameters; please refer to the following sheet for more details about parameter setting.
Parameter Note
Style It is to set the picture style, which includes standard, soft and vivid.
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Parameter

Note

Brightness

It is to adjust the image overall brightness via linear adjustment mode.
The larger the number is, the brighter the picture is, and on the contrary it
is opposite. The picture get blurry easily when the value is set too big.

Contrast

It is to adjust the picture contrast. The bigger the value is, the bigger the
bright contrast becomes, and on the contrary it is smaller. The dark area
becomes darker and the bright area becomes overexposed easily when
the value is set too big. The picture becomes blurry when the value is set
too small.

Saturation

It is to adjust the color darkness and lightness. The color becomes darker
when the value is bigger; on the contrary it becomes lighter. The value
causes no influence to the overall brightness of the image.

Sharpness

It is to adjust the sharpness level of the picture edge. The bigger the
sharpness value is, the more obvious the image edge becomes, the image
is likely to generate noise more easily when the value is set too big.

Gamma

It is to change image brightness and improve the dynamic display range of
the image via nonlinear adjustment mode. The bigger the value is, the
brighter the picture becomes, and on the contrary it is opposite.

Mirror

After mirror is enabled, the monitoring image will be displayed invertedly.

Flip

It is to change the display direction of the monitoring image.
It includes following options:
Normal: The monitoring picture is normally displayed.

Flip mode 1: The monitoring picture is displayed with clockwise
rotation 90°

Flip mode 2: The monitoring picture is displayed with anticlockwise
rotation 90°

. 180° The monitoring picture is displayed upside down.
Note:

Please set the video resolution as 1080P or lower when applying flip mode
for some devices.

EIS

It can realize electronic anti-flicker function via comparison algorithm of
image difference, which can effectively solve the problem of image jittering
during application and it can make the image clearer.

Step 3

Cl

ck ASaveo and complete the i mage parameter

N
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6.1.1.2 Exposure

Step 1

Select ASetup > Camera > Conditions >

Exposureo.
which is shown in Figure 6-2.

~ 4 I Profile Normal
> Video v E -

> Audio

» Picture

Anti-flicker | Outdoor

[=]
PEm | ode| Aut B

> ’ . » Backight Autolris @) ON ) OFF
Storage » WB o #

Py 3DNR®@ ON ©) OFF
System

» Day & Night
s Grade (=] 0 50

Network

Event

Information » IR Light

Figure 6-2
Step 2

It is to set the exposure parameter, please refer to the following sheet for more details.
Parameter Note

. You can switch to exposure mode when it is in outdoor

mode, it can realize the result in the corresponding exposure
mode.

. 50Hz: When the current is 50Hz, system can auto adjust the

exposure according to the environment brightness in case
there is any stripe.

Anti-flicker

., 60Hz: When the current is 60Hz, system can auto adjust the

exposure according to the environment brightness in case
there is any stripe.
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Parameter

Note

Mode

It is the camera exposure mode.
Note:
When #fAntcikero i s #fAOutdor o,

set as figain priorityo or fs

Different devices have different exposure modes; please
refer to the actual interface.

5

5

It includes the following options:

Auto: It can auto adjust the image brightness according to
the environment.

Gain priority: The device can auto adjust according to the
gain range which is set by priority during normal exposure
range according to the different scene brightness. The device
will auto adjust shutter value if the image brightness fails to
reach the effect and the gain value has reached to upper limit
or lower limit, which is to make the image reach the best
brightness.

Shutter priority: The device can auto adjust according to the
shutter range which is set by priority during normal exposure
range according to the different scene brightness. The device
will auto adjust shutter value if the image brightness fails to
reach the effect and the shutter value has reached to upper
limit or lower limit, which is to make the image reach the best
brightness.

Iris priority: Iris value is fixed, the device can auto adjust the
shutter value if the image brightness fails to reach effect and
the shutter value has reached the upper limit or lower limit,
the device can auto adjust the gain value to make the image
reach the best brightness.

Manual: It is to manually set gain value and shutter value,
adjust the the displayed brightness of the image.

5

Auto Iris

It can set the parameter when the camera installs auto iris.

The lens iris can auto adjust the size according to the
environment after auto iris is enabled, then the image
brightness will change accordingly.

B

The iris value reaches the max when disabling auto iris, the
lens iris will not change according to the environment
brightness.

3D NR

It is to process the image with multiframe (at least two frames), it
can realize noise reduction of the image by using the interframe
information between the previous and latter frame.

Grade

It can set the parameter when
The bigger the grade is, the better NR effect it can realize.
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Step 3

Click ASaveo tammetepconigofdameratexpasura

6.1.1.3 Backlight

Backlight mode can be divided into BLC, WDR and HLS.

BLC: it can avoid cucoloris phenomenon of the darker area in the backlight environment.

WDR: It can suppress the overbright area and compensate darker area by enabling WDR, which can
make the overall image clear.

HLC: It is to weaken the high light, which can be applied in the areas such as toll gate, entrance and exit
of the parking lot and etc. As for extreme light, it can snapshot the human face in the dark environment
and it can realize better effect for the details of the plate number.

Step 1
Select ASetup > Camera > Condition > Backlighto, th
which is shown in Figure 6-3.

Profile Normal

> Audio . |’ Ficure Mode | OFF [
Network e e . ~ » Exposure

Event ~ » Backlight

Storage B »WB
System -l » Day & Night

Information » IR Light

| Default ‘ l Refresh | | Save I

Figure 6-3

Step 2

Set the backlight parameter.

When the fAModeo i sadsaeptt aas ofnSc, e autehadpissthdsmtagem wi | |
brightness according to the environmental brightness, which is to make the object display clearly in

5

the scene.
. When the AModeo is set as @ABLCO, it can select de
E When selecting fADefaulto mode, the system can

environment, which is to make the image in the darkest area clear to be seen.
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E When selecting ACustomizedd mode, the system ¢
after it set customized area, which is to make the image of the selected area reach
appropriate brightness.
Whenthe fAiModed is set as AWDRO, it will | ower the
enhance the brightness of the area with low brightness, which is to make the objects in both high
brightness and low brightness area display clearly.
Note:
There may be video loss of a few seconds when the camera is switched from non WDR mode to WDR
mode.
., When the AModeo is set as 0 Hlrighiness df thecarea with highm wi | |
brightness and decrease the size of the halo area, which is to lower the brightness of the whole
image.
Step 3
Click ASavedo to complete the config of the backligh

6.1.1.4 WB

WB is used to restore the white object in the scene by the camera, after WB mode is set, it can make

the white object look white in different environments.

Step 1

Select ASetup > Camera > Conditions > WBO0, the syst
shown in Figure 6-4.

~ Conditions

2 Profile  Normal
> Video

b g
> Audio s Lificuc Mode | Auto E

Network f s =7 2o » Exposure

Event : — » Backlight

System » Day & Night

Information » IR Light

| Default I | Refresh I i Save ‘

Figure 6-4

Step 2
Set WB mode.
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., When the AModeo is set as AAutood, the system can
color temperatures, which is to make the image color normal.
., When the AModeo is set as ANatural 0, t heessegest em ¢

without artificial light, which is to make the image color normal.

., When the AModeo i s set as aitSdompersate whike bgladcetothdre sy st
outdoor scene at night, which is to make the image color normal.

., When the AModeofiDestdeor 6o, the system ctothermostt o cor
outdoor scenes with natural light and artificial light, which is to make the image color normal.

., When the AModeo is set as fAManual 0, i tegaimthe manual
system can compensate the different color temperatures in the environment according to the
settings.

., When the @iModegonaiCastome @ats ifis to set customized ar
compensate white balance to different color temperature of the images in the area, which is to
make the image color normal.

Step 3
Click ASavedo to complete the config of WB mode.

6.1.1.5 Day & Night

It is to set the switch between color mode and black & white mode.

Step 1

Select ASetup > CambPaw & Koghltidiamad the system wild.l
Ni ght o, whi diguré 85.shown i n

@Jhua

Profile  Normal
> Video

> Audio w tapacus Mode | Auto E
Network o e 4. - - — LR Sensitivity Middle E
Event < — » Backlight Delay 65 E]
Storage - » WB

System

» Day & Night

» IR Light

Information

Default | | Refresh I | Save I

Figure 6-5
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Step 2
Set day & night parameter; please refer to the following sheet for more details.

Parameter Note

It is to set the camera image displayed as color or black & white mode.
Note:
The setting of AiDay/ Ni ght Modeo i
Management 0.
Mode It includes the following options:
Color: The camera image is displayed as color image.
Auto: The camera can auto select color image or black & white image
to be displayed according to the environmental brightness.
. Black & white: The camera image is displayed as black & white image.
The parameter can be set when the
Sensitivity It is to set the sensitivity of the switch between image color display and
black & white display.
The parameter can be set when the
It is to set the switch delay between image color display and white & black
display. The smaller the delay is, the faster of the switch becomes between
color display and black & white display.

Delay

Step 3
Click ASaveodo to compl embde. the config of day/night

6.1.1.6 Defog

The image quality will become weak when the device is in the environment with fog or haze, you can

enable defog function to adjust the image definition.

Step 1

Select ASetup > Camera > ConditionsntebDkdogodoofanidDeh
which is shown in Figure 6-6.
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Conditions Profile Management]
3 ! B ¥ =, Profile Day
> Video s i

> Audio ' » Picture

Mode | OFF [~]
Network

» Exposure

Event » Backlight

Storage » WB
System » Day & Night

Information

Figure 6-6
Step 2
It is to set defog mode according to the actual scene.

When the fAModeo i s$stosnartualhasstinteidity and aid light modet the system
will adjust the image definition according to the intensity and air light mode which have been set
previously. As for air light mode, you can set manual or auto.

When t he # Mod e 0,the systesnentll auto adjuit he imagé definition according to the
actual scene.

When the fiModed is set as fAOffo, then the defog f

Step 3

Click ASavedo to complete the config of defog mode.
6.1.1.7 IR Light

You can directly set the mode of IR light if the device is equipped with IR light.

Step 1

Select ASetup > Camera > Conditions > IR Lighto and

which is shown in Figure 6-7.

41



@hua

Dahua Network Camera Web 3.0 Operation Manual

Conditions

Profile Normal
> Video q
> Audio B Picure Mode | SmartiR [+]
Network e s = - — » Exposure
Event » Backlight
Storage » WB
System » Day & Night
Information _“
Figure 6-7
Step 2
Itis to set IR light mode according to the actual scene.
. When the AModeo is set as AManual 6, it can manual
realize light compensation to the image according to the IR light intensity.
. When the AModeo is set as ASmart | R0, the system
actual scene.
. When the AModeo is set as AZoompriod, the system

brightness change of the actual scene.

E The system will enable near light by priority when the actual scene becomes dark, the system
will enable the far light when the near light fails to meet the requirement of scene brightness
even if it is adjusted to the brightest.

E The system will adjust far light brightness by priority to off and then adjust the brightness of
near light when the actual scene becomes bright. The system will always disable far light
when the focal length of the lens is adjusted to a certain wide angle, which is to avoid near

overexposure. Meanwhile, it can manually set light compensation to slightly adjust the
brightness of IR light.

. When the fAimodeo is set as @AOffo, it owi ||l not enatk
Step 3
Click ASaveo and colmgptl ete the config of IR
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6.1.1.8 Profile Management

Step 1

Select ASetup > Camera > Conditions > Profile Manag

AProfile Management 0.

Step 2

Set profile management.

., When the AProfil e Manage me termn will nositoracedrding te theinhrmal ma | o ,
config.

@hua T (TN e TR SN ST

Camera Conditions Profile Management Zoom and Focus @

Profile Management & Normal ¢ Full Time ¢ Schedule

> Video

> Audio Default | | Refresh | |

Network
Event
Storage
System

Information

Figure 6-8
., When the AProfile Managemento is set as #AFull Tin
ANi ght 6, t mmenitos aceotdiagtoteicloinf i g of fal ways enabl eo.

@hua

Camera Conditions Profile Management] Zoom and Focus

Profile Management ¢ Normal {* Full Time € Schedule

Always Enable Day x

> Video

> Audio

Network | Default [ | Refresh I |

Event
Storage

System

Information

Figure 6-9

When the AProfile Managemento is set as fASchedul e
period as night, for example, if it sets 0:00~12:00 as day, 12:00~24:00 as night, then the system will
monitor by adopting corresponding config in different periods.

5
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AT SN T T TN T
@

Conditions Profile Management Zoom and Focus

Profile Management ¢ Normal € Full Time { Schedule
> Video

> Audio

Network otoaseting (] \ B

0:00 4:00 8:00 12:00 16:00 20:00 24:00

Event

Storage E Day M Night

System Default H Refresh || Save |

Information

Figure 6-10
Step 3
Click ASavedo to complete the settings of profile masa
Note:
Click ADefauktbdbheteodeegsce to default config; click 7
device.
6.1.1.9 Zoom and Focus
Note:
Only motorized vari-focal devices support focus and zoom function.
Step 1
Select ASetup > Camer a > Co ntdeisystern wilkdisptay theirdeniaceaoi d F o ¢ U
iZoom and FocusoO Righre6-A1.i s shown in

@hua

Camera Conditions

> Video

> Audio
Network
Event
Storage
System
Information

zoom WDE (=) (O TELE Speed [20 ~ Restore All
Focus NEAR (=) (0 FAR  Speed [20 -] | D+JAutoFocus Refresh

Figure 6-11

Step 2
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Adjust the focal length of the lens.
Afteritiszoome d, set fASpeeddioandrmaygedheinsd, diing bl ock di
Step 3

Adjust the lens definition.

After it is focused, -f%aagtheSlgiegdldck diractlydo agjustte ss A +0, 0
Note:

Speedisusedtosetthelengthby pr essinff. in+0 and

5

., After adjusting the focal l ength of the |l ens or
image definition, it is not allowed to implement other lens operation during auto focus.
. After several times of zoom and focus,thei mage fails to be adjusted cl

reset the lens to zero and remove the accumulative error of the lens.
Click ARefresho and t hmsenchbeize the hardwaie kolthe lacatioroofnsdiding ¢ a | |
block of lens zoom and focus.

6.1.2 Video

6.1.2.1 Video

Step 1

Select ASetup > Camera > Video > Videoo and the sy
shown in Figure 6-12 (Non fisheye) or Figure 6-13 (Fisheye).

aJhua

- TECHNOLOGY

Camera Video Snapshot Overlay

> Conditions

Network Enable Sub Stream 2 v
Event Encode Mode H.264H v Encode Mode H 264H v
Storage Smart Codec OFF v * Resolution D1 (704*480) v
System Resolution 2304x1296 (230471296 ¥ Video Clip
TR S Frame rate(FPS) 30 v Framerate(FPS) |6 v
Bit Rate Type CBR v Bit Rate Type CBR v
Reference Bit Rate  1792-10240Kb/S Reference Bit Rate  48-886Kb/S
Bit Rate 6144 v Bit Rate 896 v
| Frame Interval 60 (30~150) | Frame Interval 12 (6~150)

#| Watermark Settings

Watermark Character | Digital CCTV

Default || Refresh ‘ ‘ Save

Figure 6-12 (Non fisheye)
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Snapshot

2-Conon: Installation Mode Ceiling E|
m Record Mode 2P EI
> Audio
Network Main Stream Sub Stream
Event [v] Enable Sub Stream 1 [~]
Storage Code-Stream Type | General E‘ Code-Stream Type  General E
System Encode Mode H.264 = Encode Mode H.264 [~]
L Resolution 2432x2432 (2432°2432) [+ | Resolution 640x640 (640°640)  [~]
Frame rate(FPS) 15 Izl Frame rate(FPS) 15 El
BitRate Type CBR =] Bit Rate Type CBR [~]
Reference BitRate  2048-11008Kb/S Reference BitRate  256-1792KbiS
Bit Rate 8192 [+] R 1024 [=]
| Frame Interval 30 (15~150) | Frame Interval 30 (15~150)
sve 1(off) [~] 2ve 1(off) [=]
(V] Watermark Settings
Watermark Character | Digital CCTV
Default l | Refresh | | Save

Figure 6-13 (Fisheye)

Step 2
Set video bit stream, please refer to the following sheet for more details about the parameters.

Parameter Function

It will display the parameter when the device is fisheye.
There are three installation modes for fisheye which are
ceiling, wall mount and ground installation, please
select installation mode according to the actual
installation scene of the fisheye.

The system will begin to switch after switching
installation mode, it will prompt successfully saved after
it is switched successfully.

Note:

The device end will output the dewarped video stream
after configuring installation and record mode, when the
device is accessed to third-party platform, it will directly
display the dewarped image on the third-party platform.

Installation Mode
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Parameter

Function

Record Mode

It will display the parameter when the device is fisheye.
The system will begin to switch after record mode is
switched, it will prompt saved successfully after it is
switched successfully.

The record mode will change according to the different
installation modes.

10: the original picture which is not dewarped.
1P: 360fectangular panorama.

2P: The mode can be set
Modées set as ACeilingbod
related 180fectangular image, the two sub
windows can both form 360panorama anytime.
10+3R: original image + 3 independent sub
images, both the sub image and sub boxes in the
original image can support zoom and movement.
1R: Original image + independent sub image, the
sub boxes of the original image support zoom and
movement.

4R: original image + 4 independent sub images,
both the sub image and sub boxes in the original
image support zoom and movement.

2R: Original image + 2 independent sub images,
the sub boxes of the original image can support
zoom and movement, the sub image supports up
and down movement, which can change the
vertical angle of view.

Note:

The device end will output dewarped video stream after
configuring installation and record mode, when the
device is accessed to the third-party platform, it will
directly display the dewarped image on the third-party
platform.

Sub Stream Enable

Select AEnabled t.o enabl e
The device supports enabling sub stream 1 and sub
stream 2 at the same time.

Smart Codec

It can enhance image compression performance and
reduce storage space by enabling intelligent encoding.
Note:

After intelligent encoding is enabled, the device will not
support third stream, ROI or intelligent event detection,
please refer to the actual interface for more details.
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Parameter

Function

Encode mode

There are five options: H.264 (main profile standard,
H.264H (high profile standard), H.264B (Baseline
Profile), H.265 (main profile standard) and MIJPEG
encode.
The H.264, H.264H both are H264 bit stream.
H.264 is the Main Profile encode and you need to
enable the sub stream function in your camera and
set the resolution as CIF. Then you can monitor via
the Blackberry cell phone.
The H.265 is the main profile encode mode.
MJPEG: In this encode mode, the video needs to
large bit stream to guarantee the video definition.
You can use the max bit stream value in the
recommend bit to get the better video output effect.

Resolution

There are multiple resolutions. You can select from the
dropdown list.

For each resolution, the recommended bit stream value
is different.

Note: When video is under rotating status, you cannot
set resolution higher than 1080P (excluding 1080P).

Video Clip

The function is only supported by sub stream 2, please
refer to AVideo Clipo for

Frame Rate (FPS)

PAL: 1" 25f/s° 1-50f/s NTSC: 1" 30f/s or 1~60f/s.
The frame rate may vary due to different resolutions.

Bit Rate Type

There are two options: VBR and CBR.
Please note, you can set video quality in VBR mode.
Under MJPEG mode, only CBR is available.

Recommended Bit

Recommended bit rate value according to the resolution
and frame rate you have set.

Bit Rate

In CBR, the bit rate here is the max value. In
dynamic video, system needs to low frame rate or
video quality to guarantee the value.

The value is null in VBR mode.

Please refer to recommend bit rate for the detailed
information.

SVC

Frame rate can be encoded by layer. It is a flexible
encoding method. By default, itis 1 as 1 layer. You also
can set 2/3/4 layers.

| Frame

Here you can set the P frame amount between two |
frames. The value ranges from 1 to 150. Default value
is 50.

Recommended value is frame rate *2.
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Parameter Function

Watermark Settings Sel ect fiwWatermark Setti ngiq
function. After the watermark function is enabled, you
can check if the video is tampered via verifying
watermark character.

Watermark Character It is the character of watermark verification; it is Digital
CCTV by default.
. Video Clip
1. Sel ect ASub Stredamn2boxn theckr dEgnabl eo.
2. Enable AVipd®™:cCi ck
The system will display the ikguemBifldce of HAAreao, wt
Area X

Resolution D1 (704*480) B Save Cancel

Figure 6-14
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3. Select the needed resolution and clip the needed image on the interface, which is shown in Figure
5-15.
4, Click ASaved. You can check the clipped video
interface only displays the clipped area), which is shown in Figure 6-15.

Figure 6-15

Step 3
Click ASavedo to complete video stream setup.

6.1.2.2 Snapshot
The snapshot interface is shown as in Figure 6-16.

@Jhua

Video

Snapshot

> Conditions —
Snapshot Type |Genera| v |
Image Size 1080P (1920*1080)
> Audio ——
Quality |5 M
Network R
Interval 15 v
Event |7|
Storage | Default ‘ | Refresh | ‘ Save
System
Information
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Figure 6-16
Please refer to the following sheet for detailed information.
Parameter Function
Snapshot type There are two modes: general (schedule) and Event (activation).
Image size It is the same as the resolution of main stream.
Quality It is to set the image quality. There are six levels.
Interval It is to set snapshot frequency. Optionall~7s/picture, customized.

6.1.2.3 Video Overlay

The video overlay interface is shown as in Figure 6-17.

; Audio
Network
Event
Storage
System

Information

| Y © Enable @ Disable
» Channel Title

» Time Title

» Text Overlay

» Picture Overlay

» Counting

Delete | (Or Rightelick )

Refresh | | Save

Figure 6-17
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> Conditions

@ » Privacy Masking @ Enable () Disable
v - » Channel Title Input channel title:
> Audio

— » Time Title IPC
Network N TS =

=~ e Vs rl:
Event . < ‘ » Text Overlay
Storage V. » Picture Overlay
System » Counting
Information

Defautt ||

Figure 6-18

@Jhua

Camera Snapshot

3 Overlay
> Conditions

Path

» Privacy Masking  ‘® Enable Disable

» Channel Title Week Display

> Audio
Network

Event » Text Overlay

Storage » Picture Overlay

System » Counting

Information

Defaut |[ Refesn [ sawe

T S N SR R SRR

Figure 6-19
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> Conditions

» Privacy Masking () Enable @ Disable

_— - » Channel Title Input Text:
o

» Time Title
Network

Event : o T

Storage » Picture Overlay

System 2 » Counting

Information
Text Align

Right

Snapshot
> Conditions

» Privacy Masking () Enable © Disable
» Channel Title Picture Preview:
udio

» Time Title

Network —

i o Te il
Event 5 - » Text Overlay
System 4 » Counting

Information

Upload Picture

Requirement for picture upload
1. Max size is 16k.

2. Max resolution is 128x128 pixels.
3. 256 colors, bmp format.

Figure 6-21
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@Jhua

Snapshot
> Conditions
T
> Audio
Network

» Privacy Masking ) Enable © Disable
| » Channel Title Statistics Type
N ) Time Title [v] Enter Number

V| Leave Number

Event » Text Overlay

i Text Al
Storage = » Picture Overlay ign

5 ; : Left

Information

Figure 6-22

Please refer to the following sheet for detailed information.

Parameter Function

Here you can privacy mask the specified video in the
monitor video.

System max supports 4 privacy mask zones.

Privacy Masking | -

Time Title . You can enable this function so that system overlays time
information in video window.
You can use the mouse to drag the time tile position.

Channel Title . You can enable this function so that system overlays
channel information in video window.
You can use the mouse to drag the channel tile position.

You can enable this function to overlay text in video
window.

Private protocol is connected to mobile NVR, support GPS
information overlay.

You can use the mouse to drag location box to adjust its
position. Alignment include align left and align right.

Text Overlay s

You can enable this function to display overlay picture.
Click on disable to turn it off.

Click on Upload Picture to overlay local picture into
monitoring window. You can drag the yellow box to move
it.

Note:

You cannot enable text and picture overlay at the same time.

Picture Overlay | -
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Counting , Check i Bnriaptay tee@ounting statistics data in
the video monitoring windoWw
display.

There are enter number and leave number for statistics
type and left align and right align for OSD info.
Set privacy mask, channel title, time title, location, overlay

Refresh s .
and save the change. You can click on Refresh to see
effect.
Default . Click it to restore default config.
Save . Click it to complete video settings.
6.1.2.4 ROI
Note: Some series dondét support ROI setup fu

Enable '® Disable

s Audio | Image Quality | 6(best) v

Network
Event
Storage
System

Information

Remove Al || Delete | (orRightcick)

| Default | l Refresh l I Save I

Figure 6-23
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Camera Snapshot
> Conditions
> Audio
Network

Overlay Path

Enable '@ Disable

Image Quality |6(best) v

Event
Storage
System

Information

Remove All Delete {Or Rightclick )

| Default | l Refresh | I Save

Figure 6-24
Parameters | Note
Check AEnabledo, then it wildl di splay th
Enable L X . R .
Check nADisabled, then it wondt displ ay.
Set the image quality of ROI, ranging from 1" 6, default is 6.
Image Note:
Quality For fisheye device, it ranges from 1~6 (best), default is 6 (best)
Able to set area block, max 4 areas.
6.1.2.5 Path

The storage path interface is shown as in Figure 6-25.
Here you can set snap image saved path and the record storage path.
The default monitor image path is C:\Users\admin\WebDownload\LiveSnhapshot.
The default monitor record path is C:\Users\admin\WebDownload\LiveRecord.
The default playback snapshot path is C:\Users\admin\WebDownload\PlaybackSnapshot.
The default playback download path is C:\Users\admin\WebDownload\PlaybackRecord.
The default playback cut path is: C:\Users\admin\WebDownload\VideoClips.
Note:
Admin is locally logged in PC account.
Please click the Save button to save current setup.
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TECHNOLOGY

Video Snapshot

onditions
E Live Snapshot C:\Users\admin\WebDownload\LiveSnapshot Browse...
. - . Live Record C:\Users\admin\WebDownload\LiveRecord Browise...
> Audio
Playback Snapshot  C:\Users\admin\WebDownload\PlaybackSnapshot Browse...
Network
Event Playback Download = C:\Users\admin\WebDownload\PlaybackRecord Browse...
ven
Video Clips C:\Users\admin\WebDownload\VideoClips Browse...
Storage
System Default | I Save

Information

Figure 6-25

6.1.3 Audio

Please note some series devices do not support audio function.
6.1.3.1 Audio

The audio interface is shown as below. See Figure 6-26.

Ca Audio
> Co

> Video [ Encode
Network [v] Enable
Event Encode Mode G.71A [~]
Storage Sampling Frequency | 16k E
System
Information SuStroam
[C] Enable Sub Stream 1 E
Encode Mode G.711A
Sampling Frequency | 16k E
—— Affribute
Audioln Type Lineln
Noise Filter Enable [+]
Wicrophone Volume (=] O 50
SpeakerVolume  [=] D 50
Default ] l Refresh | | Save |

Figure 6-26

Please refer to the following sheet for detailed information.
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Parameter

Function

Enable

You can enable audio only when video is enabled.

Aftersel ecting the AEnabl ed of m
network transmission stream is the audio/video composite
stream, otherwise it only includes video image.
Encode mode The encode mode of the main stream and extra stream include
G.711A, G.711Mu, G.726 and ACC. The default mode is
G.711A.
The setup here is for audio encode mode and the bidirectional
talk encode both.
Sampling The sampling frequency of audio. It includes the following
Frequency options:
8K
. 16K
., 32K
. 48K
. 64K
Audioln Type Two modes to select: Lineln, Mic.
Device needs to connect external audio input source under
Lineln mode, and it doesndt n
input source under Mic mode.
Noise Filter Enable the function and it can filter relevant noise.
Microphone Adjust microphone volume from 0" 100.
Volume

Note:
Supported by some devices.

Speaker Volume

Adjust speaker volume from 0" 100.
Note:
Supported by some devices.

6.1.3.2 Alarm audio
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@Jhua

Alarm Audio
> Conditions
2Mideo alarm1.pcm
| Audic. 1 o alarm2.pcm (]
Network
Event
Storage
System

Information

Add Audio File

Figure 6-27
Add Audio File [ 3|
= Record = Upload
Audio File | pcm
FRecord
Figure 6-28

Audio management currently supports PCM format to record and PCM, wav two forms to upload” and

can select an audio file for the audio alarm linkage.
The way to download the web alarm playback audio file into local is as follows:

Step 1 Use the left mouse button to click the hollow circle “in the fAchoicedandol

@ . . . . )
shows =~ which means effective choice of alarm audio.

Step 2 Use the right mouse button to click x- select Asave target

6.2 Network
6.2.1 TCP/IP

The TCP/IP interface is shown as in Figure 6-29. It supports IPv4 and IPv6. IPv4 supports static IP

and DHCP. IPv6 supports static IP only. When users manually modify IP address, WEB will
automatically jump to the new IP address.

as
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Camera TCP/IP

> Connection Ethernet Card

Host Name

> PPPoE Wode

> DDNS MAC Address
> IP Filter IP Version

> SMTP(Email) IP Address

> UPnP

Subnet mask
> SNMP

Default Gateway

> Bonjour

Preferred DNS Server, 8 8

> Multicast

Alternate DNS Server | 8 8 4

> WIFI

Dahua Network Camera Web 3.0 Operation Manual

IPC

Wire(DEFAULT) -~

@ static © DHCP

1Pvd -
172 . 29 36
255 255

2
0
172 . 29 0
8

0
1
8
4

IV Enable ARP/Ping to setIP address senvice

> 802.1x

> QoS
Event
Storage
System
Information

Default ‘ \ Refresh 1 i Save

Figure 6-29
Please refer to the following sheet for detailed information.

Parameter Function

Host Name It is to set current host device name. It max supports 15
characters.

Ethernet Card Please select the Ethernet port. Default is wired.

Please note you can modify the default Ethernet card if there is
more than one card.

Mode There are two modes: static mode and the DHCP mode. Select
DHCP mode, it auto searches IP, and you cannot set IP/subnet
mask/gateway. Select static mode, you must manually set
IP/subnet mask/gateway.

Mac Address It is to display hose Mac address.

IP Version It is to select IP version. IPV4 or IPV6.

You can access the IP address of these two versions.

IP Address Please use the keyboard to input the corresponding number to
modify the IP address and then set the corresponding subnet
mask and the default gateway.

Preferred DNS DNS IP address.

Alternate DNS Alternate DNS IP address.
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Enable You can use ARP/Ping command to modify or set the device IP
ARP/Ping set address if you know the device MAC address.

device IP Before the operation, please make sure the network camera
address service. | and the PC in the same LAN. This function is on by default.

You can refer to the steps listed below.

Step 1: Get an IP address. Set the network camera and the PC
in the same LAN.

Step 2: Get the physical address from the label of the network
camera.

Step 3: Go to the Run interface and then input the following
commands.

arp s <IP Address> <MAC>
ping il 480 it <IP Address>
Suchas arp -s 192.168.0.125 11-40-8c-18-10-11
ping -l 480 -t 192.168.0.125
Step 4: Reboot the device.

Step 5: You can see the setup is OK if you can see there are

out put information such as AR
the command output lines. Now you can close the command
line.

Step 6: Open the browse and then input http://<IP address>.
Click the Enter button, you can access now.

6.2.1.1 Easydip

Click AEnabled to connect the device to network,
client of Easy4ip after #AO0Onlined is displ aynanberon
or scan QR code). See Figure 6-30.

@Jhua

Camera TCP/IP

> Connection

Easydip

[T] Enable

Status Offiine
> PPPOE

SIN 1K037FCPAW00213
> DDNS

OR Code
> IP Filter

> SMTP(Email)

> UPnP

> SNMP [ oeur |[ Reesn [[  saw

> Bonjour

> Multicast

> 802.1x
> QoS
> HTTPs

Event

Storage

System
Information

Figure 6-30
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6.2.2 Connection

6.2.2.1 Connection

The connection interface is shown as in Figure 6-31.

@Jhua

Camera

> TCPI
__Connection
> PPPoE

> DDNS

> IP Filter

> SMTP(Email)
> UPnP

> SNMP

> Bonjour

> Multicast

> 802.1x

> QoS

> HTTPs
Event

Storage

System

Information

Connection

Max Connection 10 (1~20)

TCP Port 37777 (1025~65534)
UDP Port 37778 (1025~65534)
HTTP Port 80

RTSP Port 554

HTTPs Port 443

Default J | Refresh l | Save

Figure 6-31
Please refer to the following sheet for detailed information.
Parameter | Function
Max It is the max Web connection for the same device. The value ranges from 1
connection | to 20. Default connection amount is 10.
TCP port Port range is 1025~65534. The default value is 37777. You can input the
actual port number if necessary.
UDP port | Portrange is 1025~65534. The default value is 37778. You can input the
actual port number if necessary.
HTTP port | Port range is 1025~65524. The default value is 80. You can input the
actual port number if necessary.
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RTSP port |, The default value is 554. Please leave blank if use default. User uses
QuickTime or VLC can play the following formats. BlackBerry can play
too.

Real-time monitoring URL format, please require real-time RTSP
media server, require channel no., bit stream type in URL. You may
need username and password.

User uses BlackBerry need to set encode mode to H.264B, resolution
to CIF and turn off audio.

URL format is:
rtsp://username:password@ip:port/cam/realmonitor?channel=1&subtype=0
Username/password/IP and port.

The IP is device IP and the port default value is 554. You can leave it in
blank if it is the default value.

Follow standard RTP protocol and when encode mode is MJPEG, the max
resolution only supports 2040*2040.

HTTPs HTTPs communication port, range is 1025~65534, default is 443.
Port

Note:
0" 1024, 37780° 37880, 1900, 3800, 5000, 5050, 9999, 37776, 39999, 42323 are all special ports.
User cannot modify them.
Avoid using default port value of other ports.

6.2.2.2 ONVIF

ONVIF Open Network Video Interface Forum™ ~ this standard describes network video mode,
interface, data type and data interaction mode. ONVIF St a n d a r d Gosacheve mnetwsrk video
frame agreement and makes the network video products (including video front-end, video equipment,
etc.) from different manufacturers completely compatible.

ONVIF function is on by default.
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> TCPIP Authentication ® ON () OFF

Default | l Refresh | |

> IP Filter
> SMTP(Email)
> UPnP

> SNMP

> Bonjour
> Multicast
> 802.1x
> QoS

> HTTPs
Event
Storage

System

Information

Figure 6-32

6.2.3 PPPoE
The PPPoE interface is shown as in Figure 6-33.
Enter the PPPOE username and password which are provided by ISP (Internet Service Provider), and

click AEnabl edo. TIhaatonmtcallyestabksh wetworle cormection in the mode of

PPPoOE afteritisenabled;af t er it i s successful, the I P of the i
into the dynamic IP address of the acquired WAN.

Note:

After PPPoE dial-up is successful, it needs to log in the device via the IP which is set before dial-up; in
the PPPOE setup interface, it will display the registered IP address, and then it can visit the IP address
via client.

Please disable UPnP when clicking PPPOE enable, which is to avoid causing influence to PPPoE dial-
up.
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> TCPAP

> Connection
PPPoE

> DDNS

> IP Filter

> SMTP(Email)

> UPnP

> SNMP

> Bonjour

> Multicast

> 802 1x

> QoS

Event

Storage

System

Information

6.2.4 DDNS

The DDNS interface is shown as in Figure 6-34.

The DDNS is to set to connect the various servers so that you can access the system via the server.
Please go to the corresponding service website to apply a domain name and then access the system
via the domain. It works even your IP address has changed. When the device connects to WLAN, you
should disable UPnP.

hua

TECHNOLOGY

Camera
> TCPAP
> Connection

> PPPOE

> IP Filter

> SMTP(Email)
> UPnP

> SNMP

> Bonjour

> Multicast

> 802.1x

> QoS

> HTTPs
Event

Storage

System

Information

_ DDNs

Dahua Network Camera Web 3.0 Operation Manual

PPPOE

[] Enable
Username

Password

Figure 6-33

DDNS

[T] sewver Type Dahua DDNS E:l
Server Address
Mode ©) Auto _) Manual
Domain Name £ dahuaddns.com
Username (Optional)Please input the mailbox
Default I ! Refresh J \ Save

Figure 6-34

Please refer to the following sheet for detailed information.
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Parameter

Function

Server Type

You can select DDNS protocol from the dropdown list: CN99
DDNS, NO-IP DDNS, Dyndns DDNS, and Dahua DDNS. The
default is Dahua DDNS.

Server Address

DDNS server IP address

CN99 DDNS

Server address: www.3322.0rg

NO-IP DDNS

Server address: dynupdate.no-ip.com
Dyndns DDNS

Server address: members.dyndns.org
Dahua DDNS

Server address www.dahuaddns.com

Mode

Default is auto, able to choose manual

Domain Name

Both autoand manualar e fawlAdO esss. dahuad

default, able to set prefix manually.

Username

The user name you input to log in the server, optional.

The CN99 DDNS interface is shown as in Figure 6-35.
@Jhua

Camera DDNS
Network
> TCPIP

[T Server Type

Server Address
> Connection

Domain Name
> PPPoE

> IP Fitter

Usemame

Password

> SMTP(Email) Update Period
> UPnP

> SNMP

> Bonjour

> Multicast

> 802 1x

> QoS

Event

Storage

System
Information

CN%9 DDNS

10 Minute (1~500)

Default | | Refresh | ‘ Save

Figure 6-35
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Parameter Function

Server Type You can select CN99 DDNS protocol

Server Address | Under CN99 DDNS the default server address is inww.3322.0rgo

Domain Name Self-defined domain name

Username The user name you input to log in the server.

Password The password you input to log in the server

The refresh period of the connection between the device IP and the server, default

Refresh Period | 1015 minutes.

6.2.5 IP filter

The IP filter interface is shown as in Figure 6-36.

You can enable IP filter function so that some specified IP/MAC user can access the network camera.
You can add IP address or IP segment.

If you do not check the box here, it means there is on access limit.

Here you can add IP address and MAC address. You must add these addresses before enabling the
trusted sites.

Please note: You must set MAC address in the same network segment.

IP Filter

Trusted Sites
> TCPIP

Trusted Sites

> Connection 1P address /MAC address
> PPPoE
> DDNS
> SMTP(Email)
> UPnP
> SNMP

> Bonjour

> Multicast

> 8021x Add IP/MAG

> Qos

‘ Default | ‘ Refresh, | ‘ Save
Event

Storage

System

Information

Figure 6-36

6.2.6 SMTP”~ e-mail)
The SMTP interface is shown as in Figure 6-37.
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@lhua

Camera SMTP(Email)

Network SMTP Server none
> TCPAP

Port 25
> Connection

Anonymity

> PPPoE

Username
> DDNS
> IP Filter Fasswor

SMTR(Emai) Sender none

s Authentication None [=]
> SNMP

Title Attachment
> Bonjour

Mail Receiver
> Multicast
> 802.1x
> QoS
Event Interval 0 Second (0~3600)
Storage [ Health Mail Update Period Second (1~3600)
System

. Email Test
Information
[ et |[  Remesn J[  sae

Figure 6-37
Please refer to the following sheet for detailed information.
Parameter Function
SMTP Server Input server address and then enable this function.
Port Default value is 25. You can modify it if necessary.
Anonymity For the server which supports the anonymity email function, it
wondt display the informatio
User Name The user name of the sender email account.
Password The password of sender email account.
Sender Sender email address.
Authentication You can select SSL, TLS or none.
(Encryption
mode)
Title (Subject) Input email subject here.
Attachment System can send out the email of the snapshot picture once

you check the box here.

Mail receiver Input receiver email address here. Max three addresses.
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Parameter Function

The send interval ranges from 0 to 3600 seconds. 0 means
there is no interval.

Please note system will not send out the email immediately
when the alarm occurs. When the alarm, motion detection or
the abnormity event activates the email, system sends out the
email according to the interval you specified here. This
function is very useful when there are too many emails
activated by the abnormity events, which may result in heavy
load for the email server.

Please check the box here to enable this function.

Interval

Health mail
enable

The system will automatically sent out a email once to test the
connection is OK or not .Before the email test, please save
the email setup information.

Email test

6.2.7 UPnP

It allows you to establish the mapping relationship between the LAN and the public network.

Here you can also add, modify or remove UPnP item. For UPnP on different routers, you must disable

UPnNP function. See Figure 6-38.

In the Windows OS, From Start->Control Panel-> Add or remove programs. Cl i ck
WindowsComponeamtdsd hen select the ANetwork Serviceso f
Click the Details button and then alyeak dt ICo ndndr rotl e rc

AUPNP User Interfaced. Please click OK to begin ins
Enable UPnP from the Web. If your UPnP is enabled in the Windows OS, the network camera can auto
detect it via the AMy Network Pl aceso

Under manual mode, you can modify external port. Under auto mode, select idle port for auto port
mapping without user modification.
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UPnP

[C] Enable Mode | Manual E Router State Mapping Failed
Port Mapping List
& BT Service Name Protocol Internal Port External Port Status Modify
> PPPoE HTTP WebService TCP 80 8080 Mapping Failed A
> DDNS TCP PrivService TCP 3777 37T Mapping Failed K.
> IP Filter ubpP PrivService:UDP 37778 37778 Mapping Failed £
> SMTP(Email) RTSP RTSPService: TCP 554 554 Mapping Failed i

UPnP
> SNMP

> Bonjour

> Multicast

> 802 1x

> QoS

Event
Storage
System
Information

Figure 6-38

6.2.8 SNMP

The SNMP interface is shown as in Figure 6-39 and Figure 6-40.

The SNMP allows the communication between the network management work station software and the
proxy of the managed device. Please install the software such as MG MibBrowser 8.0c software or
establish the SNMP service before you use this function. You need to reboot the device to activate the
new setup.

SNMP

SNMP Version [7] SNMPv1 [] SNMP w2 [] SNMPv3

> Connection SNMP Port 161 (1~65535)
> PPPoE Read Community public

> DDNS Write Community private

> IP Filter Trap Address

> SMTP(Email) Trap Port 162

> UPnP

SNMP

> Bonjour

> Multicast
> 802.1x
> QoS
Event

Storage

System

Information

Figure 6-39

Please refer to the following sheet for detailed information.
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Parameter Function

SNMP Version Check SNMP v1, device only process vl info.
Check SNMP v2, device only process v2 info.

Check SNMP v3, can set username, password and
encryption method. Server calibrate corresponding
username, password and encryption method too access
device and v1/v2 are unavailable.

SNMP port The listening port of the proxy program of the device. Itis a
UDP port not a TCP port. The value ranges from 1 to 65535.
The default value is 161

Community It is a string, as command between management and proxy, ,
defining a proxy, and a man

Read-only access to all SNMP targets, default is public.
Note: Only number, letter, , and i supported.
Read/write access to all SNMP targets, default is private.
Note: Only number, letter, , and i supported.

The destination address of the Trap information from the
proxy program of the device.

Read community

Write community

Trap address

Trap Address Address where to send Trap message.

Port which send Trap message, default is 162, range

Trap Port
1~65535.

@hua

Camera SNMP
Network

SNMP Version SNMP v1 SNMP v2 SNMP v3
> TCPIP

> Connection SNMP Port 161 (1~65535)
> PPPOE Read Community public

> DDNS Wite Community private

> IP Filter Trap Address

> SMTP(Email) Trap Port 182

> UPnP

SNMP

> Bonjour Authentication Type @ MDs O SHA

Read-only Usemame public

> Multicast Authentication Password
> 802.1x Encryption Type @ CBC-DES
> QoS Encryption Password

Event
Storage Read&write Username private
system Authentication Type © MDE () SHA
Information Authentication Password

Encryption Type @ CBC-DES

Encryption Password

Deaut || Refesn ][ sae

Figure 6-40
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Check SNMP v3 version and SNMP port, read community, write community, Trap address, Trap port
are same with SNMP v1 and SNMP v2 versions. Only when SNMP version is SNMP v3, users need to
configure parameter in chart.

Parameter Function

SNMP Version | SNMP v3

Read-only Bﬁ{gylt is public.

Username Name only can be number, letter and underline.
Read/\Write Bﬁ{gylt is private.

Username Name only can be number, letter and underline.
Authentication | You may select MD5 or SHA, default is MD5.
Authentication Password not less than 8 characters.

Password

Encryption Default is CBC-DES.

Encryption Password not less than 8 characters.

Password

6.2.9 Bonjour

The Bonjour interface is shown as below. See Figure 6-41.

Bonjour is based on the multicast DNS service from the Apple. The Bonjour device can automatically
broadcast its service information and listen to the service information from other device.

You can use the browse of the Bonjour service in the same LAN to search the network camera device
and then access if you do not know the network camera information such as IP address.

You can view the server name when the network camera is detected by the Bonjour. Please note the
safari browse support this function. Click the fDisplay All Bookmarks: and open the Bonjour, system can
auto detect the network camera of the Bonjour function in the LAN.

> Connection
> PPPoE

> DDNS

> IP Fitter

> SMTP(Email)
> UPnP

> SNMP

> Mulicast

> 802.1x

> QoS
Event
Storage
System
Information

Benjour
Enable

Server Name PZCAEW24200002

Detaut ||
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Figure 6-41

6.2.10 Multicast
The multicast interface is shown as in Figure 6-42.

Multicast is a transmission mode of data packet. When there is multiple-host to receive the same data
packet, multiple-cast is the best option to reduce the broad width and the CPU load. The source host

can just send out one data to transit. This function also depends on the relationship of the group
member and group of the outer.
Note

. Open preview, streaming media protocol, select multicast, and monitor via multicast format.
. Here you can set multicast address and port. You also need to go to Live interface to set the
protocol as Multicast.

@Jhua

Camera Multicast
Network
> TCPIP

Main Stream Sub Stream
Enable Enable
> Connection
Muiticast Address 224 . 1 . 2 . 4 |(224.0.0.0~239.255.255.255) Multicast Address 224 .1 2 . 4 |(224.0.0.0~239.255.255.255)
> PPPoE
Port 40000 (1025~65534) Port 40002 (1025~65534)
> DDNS

> IP Filter

> SMTP{Email) Refresh

> UPnP

> SNMP

> Bonjour
> 802 1x
> QoS
Event

Storage

system

Information

Figure 6-42

Please refer to the following sheet for detailed information.

Parameter Function

Enable Select to enable multicast function. Main stream and sub stream cannot be
used at the same time.

Multicast address Main/sub stream multicast default address is 224.1.2.4 and its range is
224.0.0.0° 239.255.255.255.

Port Multicast port. Main stream is 40000, sub streaml is 40016,sub stream?2 is
40032 and the range is 1025 65534.
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Note: This function is only for series with 4G module.
4G is a mobile communication system which makes wireless communication integrates with Internet
and multimedia communication.

6.2.11.1 Dialing Setting

TECHNOLOGY

Camera Dialing Setting | Mobile Settings

Network
> TCPIP Wireless Net Type Auto E] [v] Enable
> Connection APN 3gnet
> DDNS Authorize Mode No E]
> IP Filter Dial-up Number *99#
> SMTP(Email) Username
> UPnP Password
2 Homion Update Period 30 =aced
> Multicast Time Range
> QoS
_ Wireless Network State
IP Address
Event
Storage Wireless Signal WCDMA 0%
System FDD-LTE i 70%
Information Default | l Refresh | | Save

Wireless Net Type

Auto, WCDMA, FDD-LTE optional, you can select according
to the operator.

Enable

Check to enable 4G module.

APN

It shall be acquired from the operator according to the setup
of operator.

Authentication Mode

Auto, PAP and CHAP, the authentication algorithm is
different according to different operators.

Dial-up Number

The number is different according to different operator, it can
be acquired from operator.

User name

It shall be acquired from the operator.

Password

It shall be acquired from the operator.

Update Period

It is the period beyond the dial-up period which has been
set, it is 30s by default, which means the device can auto
acquire 4G dial-up status, cut off dial-up to save flow.
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Time Range It is the time period to set dial-up. It can activate the function
via message to enable/disable dial-up function if it is
beyond the time period.

IP Address It will display the acquired IP after the dial-up is successful

via 4G.

6.2.11.2 Mobile Setting
ua

TECHNOLOGY

Camera Dialing Setting

Networl

> TCPAP [C] Message Send

> Connection Receiver
> DDNS

> IP Filter

> SMTP(Email)

> UPnP

> Bonjour

> Multicast

> QoS

Event

Storage

System

Information

Mobile Settings

[T] Message Activation [T} Phone Activation

+ Sender + Caller +

Title Event Message

Defaut_ || Refesn || Save

Figure 6-44

Please refer to the following sheet for detailed information.

Parameter

Function

Message Send

In the event, after the corresponding message activation is
enabled, it will send message to the phone of receiver when
event happens. It needs to enable the function of message
activation function in the event interface when using the
function.

Message
Activation

It can send message ON/OFF to the SIM card inside the device by
the mobile phone in the list, which is to enable /disable the dial-up
function and send REBOOT to restart the device.

Phone Activation

You can use the mobile phone in the calling list to call the SIM card
inside the device to enable dial-up function.

6.2.12 WIFI
Note:
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Some series devices donét support W FI and WPS func
WPS function is supported by the devices with WPS button.

6.2.12.1 WIFI

WIFI info can show the name, status,| P i nf or mati on of the CurReénesHOt
WIFI work information after reconnection to ensure the real-time display of the work status, because it

often takes some time to connect WIFI Hot Spot, which depends on the network signal strength.

S [ e | sewp | mam_ | togout |
®@

Camera WIFI

I Enable [Losdoss, || seacnssio, |

> TCPAP

> Connection
> PPPoE

> DDNS

> IP Filter

> SMTP(Email)
> UPnP

> SNMP

> Bonjour

> Multicast

JWEL [ wirnro

> 802.1x Current Hot Spot
> QoS IP address
Event Subnetmask
Default Gateway

Storage

System

Information

Figure 6-45

WIFI setting method is as follows:

, ¥ Enable . .
Step 1 Click W= - show as ” means enabling WIFI function.

St ep 2 Sé&alch SSKDOQ @&nd shows the wireless network hot spot of the current network camera
environment in the list.
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ELUTE]

Camera WIFI

o IV Enable
> TCPAP
> Connection
> PPPoE
> DDNS
> IP Filter
> SMTP(Email)
> UPnP
> SNMP
> Bonjour

> Multicast

12345
5370test
TP-LINK_465EF6

AndroidAP

TP-LINK_425796

NETGEARG4

TP-LINK_NUIAN

Dahua Network Camera Web 3.0 Operation Manual

Add SSID

H Search SSID 1

WPA-PSK-AES
WPANPAZ-PSK-TKIP+AES
WPA-PSK-TKIP+AES
WPAZ-PSK-AES
WPANPA2-PSK-TKIP+AES
NONE

WPAWPA2-PSK-TKIP+AES

> 802.1x
> QoS IP addre

Event

Storage

WIFI INFO
CurrentHot Spot  unconnected

SS

Subnetmask
Default Gateway

System

Information

when

Figure 6-46

need

to

Step3 CIl i AddSSH Do a dnanually pap outan irdesface im e t wo r k

the figure below, and enter network ID in the dialog box.

Add Wireless SSID (X!

SSID

Ok Cancel

Figure 6-47
Step 4 Double click on one can pop out the signal intensity and authentication of the hot spot.

¥ Please enter the password if necessary. Please keep the choice of password index number
same as the router when entering password.

ck unnecessary to €

¥ Pl ease cli ficonnecto i f it i s

6.2.12.2 WPS
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WIFI

 Enter PIN
PIN:

> Connection

SSID

> PPPoE

> DDNS

> IP Filter

€ Button

Status disconnected

> SMTP(Email) Connecting I | Refresh
> UPnP

> SNMP

> Bonjour
> Multicast
> 802.1x
> QoS

Event

Storage

System

Information

Figure 6-48
PIN Numberand SSIDarebot h acquired from the router, please 7
to ensure the real-time display of work state after filling in correctly.

6.2.13 802.1x

802.1x (port based network access control protocol) supports manual selection of authentication
method to control if device connected to LAN can join the LAN. It well supports authentication, charging,
safety and management requirement of network.

802.1x

7] Enable
> TCPAP
Authentication
> Connection
Usemame
> PPPoE

> DDNS Password

> IP Filter

> SMTP(Email)

> UPnP

> SNMP
> Bonjour
> Mulicast
> QoS
Event

Storage

System

Information

Figure 6-49

Please refer to the following sheet for detailed information.
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Parameter Function

Authentication | PEAP (protected EAP protocol).

Username It needs the username to login, which is authenticated by the
server.
Password Please input password here.
6.2.14 QoS

The QoS interface is shown as below. See Figure 6-50.

Qos (Quality of Service) is network security mechanism. It is a technology to fix the network delay and
jam problem and etc. For the network service, the quality of service includes the transmission bandwidth,
delay, the packet loss and etc. We can guarantee the transmission bandwidth, lower the delay, and
reduce the loss of the data packet and anti-dither to enhance the quality.

We can set the DSCP (Differentiated Services Code Point) of the IP to distinguish the data packet so
that the router or the hub can provide different services for various data packets. It can select the
different queues according to the priority (64 different priority levels) of the packets and select the
bandwidth of the each queue. Level 0 is the lowest, and level 63 is the highest. It can also discard at the
different ratio when the broad bandwidth is jam.

@Jhua

Camera Qos
Network

Realtime Monitor
> TCPAP

Command
> Connection

> PPPoE

> DDNS
> IP Filter
> SMTP(Email)
> UPnP
> SNMP
> Bonjour
> Multicast
> 802 1x
[ o |
Event

Storage

System

Information

Figure 6-50
Please refer to the following sheet for detailed information.
Parameter Function
Real-time The value ranges from 0 to 63. The router or the switcher can
monitor provide different service for various data packets.
Command The value ranges from 0 to 63. The router or the switcher can
provide different service for various data packets.

79



h
Calmya Dahua Network Camera Web 3.0 Operation Manual

Parameter Function
Enable Check it to enable QoS.
Wireless QoS

6.2.15HTTPs

In the HTTPs setting interface, users can make PC log in normally via HTTPs by creating certificate or
uploading signed certificate, which is to guarantee the security of communication data and provide
safeguard for user information and device security with reliable and stable technical means.

Step 1
Create certificate or upload the signed certificate.
., Please refer to the following steps if you select

1. Sel ect ASetup > Network > HTTPso0, and the system
shown in Figure 6-51.

@lhua

> TCPIP [C] Enable HTTPs

> Connection Create Certificate

> DDNS Request Created

> IP Filter
Request Created I |

I | Download

> SMTP(Email)

S UPRP Install Signed Certificate
nl

> SNMP Certificate Path Browse...

> Bonjour Certificate Key Path Browse... | ‘

> Multicast Certificate Installed

> 802.1x Certificate Installed |:]
2803 Attribute

Event

Storage Refresh I I Save

System

Information

2. Click roiteidgogpautt he di al og box of A HFIguPes6s52. whi ch i s
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HTTPs X

Country CN *e.g. CN

IP or Domain name | 10.15.15.211| 2

Validity Period 365 Day*Range :1-5000

Province ‘none

Location none

Organization ‘none

Organization Unit none

Email

Creat Cancel
Figure 6-52
3. Fill in corresponding i Co uimformatian,c | i Rerko vii Crifiiegdn.eadn da f st

It will s howCrtehaet ep rSuntpcte sosff uil | y 0 ,certifitate bdsbesre ans t he
successfully created.

Note:
Make sure the il Bthesamedhsthatdfthe davecene 0
4, Click Al nstall o an deonthe device dnd, whicksis shdwh in Figuee 6e58.r t i f i c a
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@Jhua
Camera
> TCPIP [”] Enable HTTPs
> Connection Create Certificate
i ——
> DDNS Request Created
> IP Filter

Request Created Delete | | | I | Download
> SMTP(Email)
Install Signed Certificate
> UPnP
> SNMP Certificate Path
> Bonjour Cerificate Key Path [ |
> Multicast Certificate Installed
RRl2X Certificate Installed
Attribute Issue to: HAP=10.15.15.211; C=CN; ST=none; 2

m L=none; O=none; OU=none; EM=; =
Event Issuer: HAIP=test, C=CN; ST=test, L=test, O=test; -
Storage Refresh | | Save
System
Information

Figure 6-53
~ \ . .
Click AnDownl oado. t wi || pop out the dialog
€ save s s X
o~
@‘ vld » Libraries » v I‘,‘ | Search Libraries pe) |
Organize ¥ SE > (7]
Bl Deskto - . .
g — Libraries

& Downloads

=/ Recent Places

4 o Libraries
5] Documents
J7 Music
b = Pictures

H videos

4 M Computer
> &, Local Disk (C:)
b = DISK1_VOL2 (D:)
» —a DISK1_VOL3 (E:)

File name: RootCert.cer

m

Open a library to see your files and arrange them by folder,...

—_—

& Documents
\’v/ Library

2

—

Music
Library

-

Pictures

‘\ L:brl:r-.'
\-/ J
Videos

@ Library

Save as type: | (*.cer)

“« Hide Folders

Save
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Figure 6-54
6. Doubl e click the downloaded icon of i Root Cert.cer
interface of ACertificabbeod, which is shown in Fig
Certificate ﬂ
General | Details | Certification Path |
@g Certificate Information
This CA Root certificate is not trusted. To enable trust,
install this certificate in the Trusted Root Certification
Authorities store.
Issued to: test
Issued by: test
valid from 2016/ 7/ 8 to 2020/ 7/ 7
[Install Cerﬁﬁcate...] Issuer Statement
Learn more about Eertificates
(S -
Figure 6-55
7. Click #Alnstall CertificateGenndfi tawell mpopt oWt za

shown in Figure 6-56.
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Certificate Import Wizard &

Welcome to the Certificate Import
Wizard
This wizard helps you copy certificates, certificate trust

lists, and certificate revocation lists from your disk to a
certificate store.

A certificate, which is issued by a certification authority, is
a confirmation of your identity and contains information
used to protect data or to establish secure network
connections. A certificate store is the system area where
certificates are kept.

To continue, dick Next.

< Back [ Next > ] [ Cancel ]

Figure 6-56

8. CI i cekx t3i@Nl eTousted Root Certification Authoritieso , wh i ¢ h Figures6hba.w n
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Certificate Store
Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate store, or you can spedify a location for
the certificate.

() Automatically select the certificate store based on the type of certificate
@) Place all certificates in the following store

Certificate store:
Trusted Root Certification Authorities l Browse.., l

Learn more about certificate stores

| <Back | mNext> | | cancel |

Figure 6-57

9. Click ANexto. The system wilg tOhepCaytihiecane ek mp
which is shown in Figure 6-58.
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Certificate Import Wizard
I —

Completing the Certificate Import
Wizard

The certificate will be imported after you dick Finish.

You have specified the following settings:

Certificate Store Selected by User RIS =s il &= g]ile
Content Certificate
< 1 »

| <Back || Fmsh | | Concel

Figure 6-58

10.Cl i ck fAFinisho, and it wildl pop out owhieFiguieal og bo
6-59.
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You are about to install a certificate from a certification authority (CA)
:l_i claiming to represent:

Se;uﬁty Warning

test

Windows cannot validate that the certificate is actually from "test". You
should confirm its origin by contacting "test", The following number
will assist you in this process:

Thumbprint (shal): 6D811FD2 E82313A8 663514ED 2CA36EGB 7D425FA6

Warning:

If you install this root certificate, Windows will automatically trust any
certificate issued by this CA. Installing a certificate with an unconfirmed
thumbprint is a security risk. If you click "Yes" you acknowledge this
risk.

Do you want to install this certificate?

Yes No
Figure 6-59
11.Cl i ck fYeso. It wi || pop out the dialog box of Al
certificate, which is shown in Figure 6-60.
Certificate Import Wizard ﬂ

l The import was successful,

Figure 6-60

, Please refer to the following steps if you select
1. Sel ect ASetup > Net wor k >layHhE hterfiace of HTTHPE whicl is shevm  wi | |
in Figure 6-61.
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Camera
> TCPIP [7] Enable HTTPs
> Connection Create Certificate
PO Request Created
> IP Filter
Request Created ] | | \ Download

> SMTP(Email)

Install Signed Certificate
> UPnP
> SNMP Certificate Path z Browse...
> Bonjour Certificate Key Path Browse... | Upload |
> Multicast Certificate Installed
ZREUZ K Certificate Installed :
Zitios Attribute
Event
Storage Refresh | | Save
System
Information

Figure 6-61

2. Select signed certificate and certificate key pat
3. Install root certificate, please refer to step 6~11 for more detalils.
4., Check fAEnable HTTPso60, click fiSaved. The system wi

Y

deviceo, and then the config is valid.

Reboot

A The configuration takes effect, the device is restarting now, please don't leave this page or close the browser...

Figure 6-62

5. Use HTTPs

Use HTTPs to log in.

Enter https://xx.xx.xx.xx in the browser, and it will pop out normal login interface; the browser will prompt
certificate error if the certificate is not installed, which is shown in Figure 6-63.
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Kl - (2 hitos//101515211/

N —

File Edit View Favorites Tools Help

Y Favorites | o [B B v ) MOTSAE v

‘ (& Certificate Error: Navigation Blocked |

[@ There is a problem with this website's security certificate.

The security certificate presented by this website was not issued by a trusted certificate authority.

Security certificate problems may indicate an attempt to fool you or intercept any data you send to the
server,

We recommend that you close this webpage and do not continue to this website.
@ Click here to close this webpage.

"Si' Continue to this website (not recommended).

& More information

Figure 6-63
Note:
AXX. XX.XX.XX0 is corresponding to your |
6.3 Event

6.3.1 Video detection
6.3.1.1 Motion Detection
Step 1

S el e ettp >@&\v&nt > Video Detection > Motion Detectiond6 and t he system will

Mot i on D ehichis shown méigure 6-64.

P

or

domai
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@hua

TECHNOLOGY

Camera Motion D

Network

| videoDetection |

[”] Enable

Working Period
> Audio Detection
Anti-Dither 5 Second (0~100)
> Smart Plan
Area Eﬂ
> Ivs —
> Face Detection V] Record
> People Counting Record Delay 10 Second (10~300)
> HeatMap [7] Relay-out
> Alarm Alarm Delay 10 Second (10~300)
> Abnormality —
("] Send Email
Storage
[”] Snapshot
System
Information Default I | Refresh | \ Save

Figure 6-64

Step 2

Sel ect @ En a bnotoo deteation funcioh.l e
Step 3

Set motion detection area.
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1. Click fASetupo and the system will pop oucFigurehe
6-65

Area m
Region g H =

Name 1 Region1 ‘

sensitivity (=) —————{}——(3) 60
Threshold (=) o =[] 5

Remaove All I | Delete I (Or Rightdick-)

Figure 6-65

2. Set area name, itis to set valid area of motion detection according to the actual situation, and it can
set the value of sensitivity and threshold respectively.
The bigger the sensitivity is, the easier it is to generate motion detection, the smaller the threshold is,
the easier it is to generate motion detection; the entire video image is the valid area of motion
detection by default.

Note:
Different colors represent different areas; each area can set different detection area.
The red line in the Oscillogram means triggering motion detection; green line means not triggering
motion detection.

3. Click ASaved to complete area setting.

Step 4

It is to set other parameters of motion detection, please refer to the following sheet for more details.
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Parameter

Function

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the

period range which has been set.

1. Click fASetupo and the system wil
Periodo.

2. ltis to set working period according to the following methods:

Press the left mouse button and drag it on the setup interface to set.

Click "

There are six periods to be set every day, select the check box in front

of the period, and then the period is valid.

Select week number (it selects Sunday by default, if it selects the

whole week, then it means the setup can be applied to the whole

week, you can also select the check box in front of the week number

to implement independent setting for some days).

3. Click ASaved to complete the set

5

5

5

Anti-dither

System only memorizes one event during the anti-dither period. The value
ranges from 0Os to 100s.

Area

1. Click fASetupo and the system wil

2. Setthe area name, it is to set the valid area of motion detection
according to the actual situation, and it can set its sensitivity and
threshold respectively. The higher the sensitivity is, the easier it is to
trigger motion detect, the smaller the area threshold is, the easier it is
to generate motion detect, the whole video image is the valid area of
the motion detect by default.

Note:

Different colors represent different areas; each area can set different

detection areas.

The red line in the Oscillogram means triggering motion detect, the green

line means not triggering motion detect.

3. Click ASaved to complete area se

Record

Check it and so when alarm occurs, system will auto record. You shall set
record period in Storage>Schedule and select auto record in record control
interface.

Record Delay

System can delay the record for specified time after alarm ended. The
value ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended. The|
value ranges from 10s to 300s.

Send Email If you enabled this function, System can sgnd out err_1ai| to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Audio linkage Check it and the system will play alarm audio file when alarm occurs. Use

can set the recorded or upl oadedb,
alarm audioa

Flash linkage

Check it and the flash will be on when alarm occurs, and the flash will

be off until the end of alarm after corresponding delay.
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Parameter Function

PTZ s Here you can set PTZ movement when alarm occurs. Such as go to
preset x when there is an alarm.
The event type includes: preset, tour and pattern.
You need to check the box here so that system can backup motion detectior
snapshot file. You shall set snapshot period in Storage>Schedule.

Snapshot

Step 5
Click ASaveo to c moipnldetacton.t he setting of

6.3.1.2 Video Tampering

Step 1
Sel ect ASetup > Hone Wideo Pampéiindde oa nDde ttehcet syst em wi | | di
iVideo Tamperi ngoFigutlei66® i s shown in

Camera Motion Detection jvideo Tampering] Scene Changing

[C] Enable Video Tampering [ Enable Defocus Detection

Working Period

> SmartPlan [v] Record

> Audio Detection

> Vs Record Delay 10 Second (10~300)
> Face Detection [¥] Relay-out

> People Counting Alarm Delay 10 Second (10~300)

> HeatMap [T Send Email

Alarm
& [”] Snapshot

> Abnormality

Storage Default | | Refresh I | Save

System

Information

Figure 6-66
Step 2
Set the parameter of video tampering; please refer to the following sheet for more details.
Parameter Function
Enable video You need to check the box to enable video mask detection alarm.
tampering

Enable defocus | You need to check the box to enable defocus detection alarm.
detection
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Parameter Function

Note:

It is to set the alarm period, it can enable alarm event only during the

period range which has been set.

1. Click fASetupo and thentsgstaemewof
Periodo.

2. ltis to set working period according to the following methods:

You can input time numerical value or press the left mouse button to

drag on the setup interface to set.

There are six periods to be set every day, select the check box in front

of the period, and then the period is valid.

Select week number (it selects Sunday by default, if it selects the

whole week, then it means the setup can be applied to the whole

week, you can also select the check box in front of the week number

to implement independent setting for some days).

3. Click ASaved to complete the set

Check it and so when alarm occurs, system will auto record. You shall set

Working Period

5

Record
record period in Storage>Schedule and select auto record in record control
interface.

Record Delay System can delay the record for specified time after alarm ended. The
value ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended. The

value ranges from 10s to 300s.

Send Email If you enabled this function, System can send out email to alert you when

alarm occurs and ends. User can set email address in Network>SMTP.

Check it and the system will play alarm audio file when alarm occurs. Use

can set the recorded or upl oadcedb,

alarm audi o0o0.

Check it and the flash will be on when alarm occurs, and the flash will

be off until the end of alarm after corresponding delay.

PTZ . Here you can set PTZ movement when alarm occurs. Such as go to
preset x when there is an alarm.

. The event type includes: preset, tour and pattern.

You need to check the box here so that system can backup motion detectior

shapshot file. You shall set snapshot period in Storage>Schedule.

Audio linkage

Flash linkage

Snapshot

Step 3
Click ASaveo to complete the setup of video tamper:i

6.3.1.3 Scene Changing
Step 1
Select ASetup > HonentScen¥di €CdanPeéengodt and the system
iScene Changingo Figure6-67.i s shown in
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Camera Motion Detection | Video Tampering | Scene Changing
Network
| Enable

Working Period

> SmartPlan V] Record

Event

Video Detection

> Audio Detection

> Vs Record Delay 10 Second (10~300)

> Face Detection V| Relay-out

> People Counting Alarm Delay 10 Second (10~300)

2 St _| Send Email
> Alarm

[”] Snapshot
> Abnormality

Storage Default H Refresh H Save

System

Information

Figure 6-67

Step 2
Check AEnabledo to enable the function of scene char
Step 3

It is to set the parameters of scene changing, please refer to the following sheet for more details.

Parameter Function

Note:

It is to set the alarm period, it can enable alarm event only during the

period range which has been set.

1. Click fASetupo and the system wil
Periodo.

2. ltis to set working period according to the following methods:

. You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

., There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

. Select week number (it selects Sunday by default, if it selects the
whole week, then it means the setup can be applied to the whole
week, you can also select the check box in front of the week number
to implement independent setting for some days).

Working Period

3. Click ASaved to complete the set
Record Check it and so when alarm occurs, system will auto record. You shall set
record period in Storage>Schedule and select auto record in record control
interface.
Record Delay System can delay the record for specified time after alarm ended. The

value ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended. The
value ranges from 10s to 300s.
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Parameter Function

Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

PTZ . Here you can set PTZ movement when alarm occurs. Such as go to

preset x when there is an alarm.
. The event type includes: preset, tour and pattern.

Snapshot You need to check the box here so that system can backup motion detectior
snhapshot file. You shall set snapshot period in Storage>Schedule.

Step 4
Click ASaveo to complete the setup of scene changin

6.3.2 Audio Detection
Step 1

Select ASetup > Honénand ®thedi sydDeemcwi | | di spibndy t he
which is shown in Figure 6-68.

@Jhua

Camera Audio Detection
Network

[] Enable Input Abnormal

] Enable Intensity Change

o
2 Audio Detection

I Sensitivity = 0 50
e Threshold = 0 50
> Face Detection

> People Counting

> HeatMap

> Alarm

> Abnormality

:;:::?: Working Period

Information R 5 Second (0~100)

[v] Record

Record Delay 10 Second (10~300)
[7] Relay-out

Alarm Delay 10 Second (10~300)
[7] Send Email

[~] Snapshot

Default J ‘ Refresh ‘ ‘ Save

Figure 6-68
Step 2

It is to set the parameters of audio detect, please refer to the following sheet for more details.
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Parameter Function
Enable input Sel ect AENabl e arditwpwilltiggeAdtarmovhen & detects
abnormal audio input abnormity.

Enable intensity
change

Sel ect AEnable I ntensity Changeo 4
that audio intensity change exceeds the threshold.

Sensitivity It can be judged as audio abnormity when the input volume change
exceeds continuous environment volume; users need to adjust according
to the actual environment test.

Threshold It is to set the filtered environment volume intensity, if the environmental

noise is too big, then the value needs to be set higher, users can adjust
according to the actual environment test.

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the

period range which has been set.

1. Click ASetupo amap tdwet stylsd eim twa 1l
Periodo.

2. ltis to set working period according to the following methods:

You can input time numerical value or press the left mouse button to

drag on the setup interface to set.

There are six periods to be set every day, select the check box in front

of the period, and then the period is valid.

Select week number (it selects Sunday by default, if it selects the

whole week, then it means the setup can be applied to the whole

week, you can also select the check box in front of the week number

to implement independent setting for some days).

3. Click ASaved to complete the set

B

Anti-dither

System only memorizes one event during the anti-dither period. The value
ranges from 0s to 100s.

Record

Check it and so when alarm occurs, system will auto record. You shall set
record period in Storage>Schedule and select auto record in record control
interface.

Record Delay

System can delay the record for specified time after alarm ended. The
value ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.
Alarm Delay System can delay the alarm output for specified time after alarm ended. The
value ranges from 10s to 300s.
Send Email If you enabled this function, System can sgnd out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.
PTZ . Here you can set PTZ movement when alarm occurs. Such as go to
preset x when there is an alarm.
The event type includes: preset, tour and pattern.
Snapshot You need to check the box here so that system can backup motion detectior

shapshot file. You shall set snapshot period in Storage>Schedule.
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Step 3
Clig&kvédio to complete the setup of audio detection.

6.3.3 Smart Plan

Smart plan is the master switch for intelligent ane
APeople Countingd and so on, the correspoplahisng i nte
enabled.
Step 1

Select ASetup > EWNheets ystSamarwi IPIl achiospl ay the interf
shown in Figure 6-69.

@Jhua e i c-c  ————

Camera Smart Plan &)
Network

> Video Detection
> Audio Detection

> Ivs

> Face Detection

> People Counting I Refresh “ P—

> HeatMap

> Alarm

> Abnormality

Storage

System
Information

Figure 6-69

Step 2
Click ASavedo to complete the config of smart pl an.

6.3.4 Intelligence Behavior Analytics

The basic requirements of scene selection.
The total proportion of the target shall not exceed 10% of the image.
The target size in thepimabeld¢anptxbb,|l ehs shaa
be less than 15 pixel x15 pixel (CIF image); Thehei ght and wi dth of the tar
the image; it is recommended that the target height is about 10% of the image height.
The differenceofbr i ght ness value between target and backg
Make sure the target appears at least over 2 seconds continuously in the field; the movement
distance has to be bigger than the width of the target itself and makes sure it is no less than 15
pixels (CIF image).
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Try to lower the complexity of the monitoring scene analysis if it is possible; it is not advised to use
IVS functions in the environment where the targets are dense and light change is very frequent.
Try to keep away from the areas such as glass, ground reflected light, water surface, branch,
shadow, mosquito disturbance and etc. try to keep away from the backlight scene to avoid direct
light.

6.3.4.1 IVS

6.3.4.1.1 Tripwire

It will trigger alarm when the target crosses the warning line according to the movement direction which
has been set.

It needs some time from when the target appears to when the target is confirmed, so it has to leave
some space on both sides of the warning line when setting the warning line, please do not set the
warning line near the obstructions.

Application scene: it can be applied to the scene with sparse target and there is barely any blocks
between the targets, such as the unmanned perimeter protection.

Step 1

Select ASetlWp>I¥SOEweedtstybtst em wi I | di slgSoay the interf
Step 2

Clic‘) it o set rule name and seilisshéwnin Rigure6s70e type as

Camera

Network
Rule Type
@] 1 Rule1 Tripwire v -]

> Video Detection
> Audio Detection
> Smart Plan
LS

> People Counting

> Alarm
Aoy Parameter Setup
Storage
System
Information
Direction A<->B -
[v] Objectfilter
Effective object (V| Human [¥] Motor Vehicle
Targetfilter @ Max Size 8191 * 8191 Draw Target [7] Record
(") Min Size 0 &1 0 Clear Record Delay | 10 s (10~300)
Pixel Counter 0 0 Draw Target [7] Relay-out
Alarm Delay 10 s (10~300)
[7] Send Email
[¥] Snapshot
Default I | Refresh l | Save
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Figure 6-70
Step 3
Click ADraw Ruledo to draw tripwire in the moni
tripwire setting.
Step 4
Click ADraw Targeto to draw the size model of
Step 5

Click the Draw Target behind Pixel Counter, then press and hold the left mouse button to draw a
rectangular, and then the size of the rectangular would display in the counter.

Step 6

It is to set the parameters of tripwire, please refer to the following sheet for more details.
Parameter Function
Note:

Working Period

It is to set the alarm period, it can enable alarm event only during the period

range which has been set.

1. Click fiSetupodo and the system wil/]
Periodo.

2. ltis to set working period according to the following methods:

You can input time numerical value or press the left mouse button to

drag on the setup interface to set.

There are six periods to be set every day, select the check box in front

of the period, and then the period is valid.

Select week number (it selects Sunday by default, if it selects the whole

week, then it means the setup can be applied to the whole week, you

can also select the check box in front of the week number to implement

independent setting for some days).

3. ClicakvedS t o compl ete the setup of

B

Direction

It is to set the direction of tripwire, you can select A->Ba B->Aa A<->B.

Obiject filter

Select the Obiject filter check box to enable the function, and then select the
effective object.

Select Human, and then the alarm will be triggered if any target that fits
for the human trigger rule in the system is detected.

Select Motor Vehicle, and then the alarm will be triggered if any target
that fits for the motor vehicle trigger rule in the system is detected.
Select no one, and then the alarm will be triggered if any moving object
such as human, vehicle, cat, or dog is detected.

B

B

Record

Check it and so when alarm occurs, system will auto record.

Record Delay

System can delay the record for specified time after alarm ended.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.
Alarm Delay System can delay the alarm output for specified time after alarm ended.
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Parameter Function
Send Email If you enabled this function, System can s_end out err_lail to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.
Snapshot Select ASnapshotodo and the system w
alarm occurs.
Step 7

Click ASaveo to complete the setup of tripwire.

6.3.4.2 Intrusion

Intrusion includes cross and appears.

Cross means that it will trigger alarm when the target enters or exits the area.

Appears means that it will trigger alarm when the target appears in the area.

As for the report interval of the IVS function in the area, the system will trigger an alarm if it detects
same event happened during the interval; the alarm counter will become zero if there is no same
event happened in the interval.

It needs to leave some space for target movement for the area periphery if it is to detect enter & exit
event, which is similar to the warning line.

Application scene; it can be applied to the scene where the target is sparse and there is barely any
obstruction between the targets, such as the unmanned perimeter protection.

Step 1

Sel ect ASet Yp>I¥SOEweamt t hel system wi lIVSodi spl ay t
Step 2

B
B

B

Cliﬂé it o set rule name, select t hwainFigure6-tlype a
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> Video Detection
> Audio Detection

> Smart Plan

> People Counting
> Alarm
> Abnormality

Storage

System

Information

Targetfiter (© MaxSize 8191
Min Size 0
Pixel Counter 196
Step 3
Click fADraw Ruleodo t
Step 4
Click ADraw Targeto
Step 5

Click the Draw Target behind Pixel Counter, then press and hold the left mouse button to draw a

Vs

* 8191

& 0

#1119

Clear

Draw Target

Clear
Draw Target

Figure 6-71

t
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tor

Name Rule Type <p
Rulet Intrusion v &
—Parameter Setup
Action 7] Appears [V] Cross
Direction Enter&Exit Y.
[¥] Objectfilter
Effective object [V] Human [¥] Motor Vehicle
] Record
Record Delay | 10 s (10~300)
7] Relay-out
Alarm Delay 10 s (10~300)
[ Send Email
[¥] Snapshot
| peraut || Refesh || sawe
area in the moni
model of

d argeetvin thte kideo image. e

rectangular, and then the size of the rectangular would display in the counter.

Step 6

It is to set the parameters of intrusion, please refer the following sheet for more details.
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Parameter Function

Note:

It is to set the alarm period, it can enable alarm event only during the period

range which has been set.

1. Click ASetupo and t he rsfyasctee mo fwid W
Periodo.

2. ltis to set working period according to the following methods:

You can input time numerical value or press the left mouse button to

drag on the setup interface to set.

There are six periods to be set every day, select the check box in front

of the period, and then the period is valid.

Select week number (it selects Sunday by default, if it selects the whole

week, then it means the setup can be applied to the whole week, you

can also select the check box in front of the week number to implement

independent setting for some days).

3. Click ASaved to complete the set

It is to set the action of intrusion, you can select appears and cross.

Working Period

B

Action
Direction It is to set the direction of intrusion, you can select enter, exit and
enter&exit.
Object filter Select the Obiject filter check box to enable the function, and then select the
effective object.
., Select Human, and then the alarm will be triggered if any target that fits
for the human trigger rule in the system is detected.
., Select Motor Vehicle, and then the alarm will be triggered if any target
that fits for the motor vehicle trigger rule in the system is detected.
. Select no one, and then the alarm will be triggered if any moving object
such as human, vehicle, cat, or dog is detected.
Record Check it and so when alarm occurs, system will auto record.
Record Delay System can delay the record for specified time after alarm ended.
Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.
Alarm Delay System can delay the alarm output for specified time after alarm ended.
Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.
Snapshot Select ASnapshotd and the system w
alarm occurs.
Step 7
Click ASaveo to compl.ete the setup of intrusion

6.3.4.3 Abandoned Object
Abandoned object means the system will trigger alarm if the abandoned object in the monitoring scene
exceeds the time which has been set by the users.
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Abandoned object and missing object can be confusing in a situation where both foreground and
background are complicated.
It also triggers alarm as abandoned object if there is pedestrian or vehicle staying still for too long. In
order to filter this kind of alarm, generally the abandoned object is smaller than people and vehicle;
therefore it can filter the people and vehicle via setting size. Besides, it can avoid the false alarm caused
by short stay of people via extending alarm time properly.
Application scene: It can be applied to the scene where the target is sparse and there is no obvious and
frequent light change. False alarm will be increased in the scene with high target density and frequent
blocking; false alarm will be increased in the scene where there are more people staying. As for the
detection area, try to make it simple, the function is not suitable for the area which is too complicated.
Step 1
Select fASet WPp>I¥SOEwemt t hel system wil IVSodi spl ay the ir
Step 2

CIi(‘) t o set rule name, select the rul e Rgue®&72s iA
@lhua

Camera

Network

No. Rule Name Rule Type

¥ 1 Rulet Abandoned Ob[~| @ *

2015-03-31 1341.50
> Video Detection
> Audio Detection

> Smart Plan

> Face Detection £ /AN Parameter Setup

> People Counting . | i Working Period
> HeatMap
aliaan - Keep Time 10 Second (6~3600)
> Abnormality =
Storage o [7] Record
System C a1 Record Delay | 10 Second (10~300)
Information [7] Relay-out
Alarm Delay 10 Second (10~300)
TargetFilter @ Max Size * [*] Send Email
) Min Size . E Fostto
| Default ” Refresh H Save
Figure 6-72
Step 3
Click ADraw Ruled to draw an area in the monitoring
Step 4
Click ADraw Targeto to draw the size model of filte
Step 5

It is to set the parameter of abandoned object, please refer to the following sheet for more details.
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Parameter Function

Note:

It is to set the alarm period, it can enable alarm event only during the period

range which has been set.

1. Click ASetupo and the system wil/|
Periodo.

2. ltis to set working period according to the following methods:

You can input time numerical value or press the left mouse button to

drag on the setup interface to set.

There are six periods to be set every day, select the check box in front

of the period, and then the period is valid.

Select week number (it selects Sunday by default, if it selects the whole

week, then it means the setup can be applied to the whole week, you

can also select the check box in front of the week number to implement

independent setting for some days).

3. Click ASaved to complete the set

It is to set the shortest time from when the object is abandoned to when it

Working Period

B

Keep time ,
triggers alarm.
Record Check it and so when alarm occurs, system will auto record.
Record Delay System can delay the record for specified time after alarm ended.
Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.
Alarm Delay System can delay the alarm output for specified time after alarm ended.
Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.
Snapshot Sel ect ASnapshotd and the system w
alarm occurs.
Step 5
Click ASavedo to complete the setup of abandoned

6.3.4.4 Missing Object

Missing object means the system will trigger alarm if it exceeds certain amount of time after the target is
taken away from the original scene.

The system can make statistics of the still areas in the foreground area and distinguish if it is missing
object or abandoned object according to the similarity between foreground and background, it will
trigger alarm when it exceeds the time which is set by users.

Because the system distinguishes abandoned object from missing object according to the similarity of
foreground and background, it may cause error between abandoned object and missing object in a
situation where both foreground and background are complicated.

Application scene: it can be applied to the scene where the target is sparse and there is no obvious and

frequent light change. False alarm will be increased in the scene where the target density is high and
10¢
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there is frequent obstruction; the false alarm will be increased in the scene where there are more people

staying. As for the detection area, try to make it simple, the function is not suitable for the area which is

too complicated.

Step 1

Select ASet Wp>I¥SOEwemt t hel system wil IVSodi spl ay the ir
Step 2

CIic‘) it o set rule name and select rulhomFigweee73as A Mi

@Jhua

Camera

Network

o 2015-00-1 134150 pode e gteilieg i

- M1 Rulet Missing Object[~| @ *

> Video Detection

> Audio Detection

> Smart Plan

> Face Detection = “ s = e - Parameter Setup

> People Counting < Working Period

> HeatMap

> Alarm Keep Time 10 | Second (6~3600)

> Abnormality —

Storage ! - [~] Record

System e e —— Record Delay | 10 Second (10~300)

Information [T} Relay-out

Alarm Delay 10 Second (10~300)
TargetFiter @) MaxSize = 5191 Cienemat
\ Min Size L, [¥] Snapshot
| Default “ Refresh “ Save
Figure 6-73
Step 3
. ~ < . . .

Click ADraw Ruleo to draw an area in the monitoring
Step 4

Click ADraw Targeto t o drrgetinthekideoimage.e model of filte
Step 5
It is to set the parameters of missing object, please refer to the following sheet for more details.

10¢
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Parameter

Function

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the period

range which has been set.

1. Click ASetupo and the system wil
Periodo.

2. ltis to set working period according to the following methods:

You can input time numerical value or press the left mouse button to

drag on the setup interface to set.

There are six periods to be set every day, select the check box in front

of the period, and then the period is valid.

Select week number (it selects Sunday by default, if it selects the whole

week, then it means the setup can be applied to the whole week, you

can also select the check box in front of the week number to implement

independent setting for some days).

B

3. Click ASaved to complete the set
Keep time It is to set the shortest time from when the object is missing to when it
triggers alarm.
Record Check it and so when alarm occurs, system will auto record.

Record Delay

System can delay the record for specified time after alarm ended.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.
Alarm Delay System can delay the alarm output for specified time after alarm ended.
Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.
Snapshot Sel ect ASnapshotd and the system w
alarm occurs.
Step 5
Click ASavedo to complete the setup of missing objec
6.3.5 Face Detection
Step 1
Select ASetup > Event > Face Detectiond and the sys

which is shown in Figure 6-74.
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Camera Face Detection

Network
> Video Detection !‘

> Audio Detection

> Smart Plan

> Vs .

_Face Deteciion ;

> People Counting {he
> HeatMap
> Alarm

(4
¥,
¥ L

1
1
}
1
I

v| Enable

Working Period

[] Enable Face Enhancement

] Record

targe

Record Delay 10 Second (10~300)
] Relay-out
Alarm Delay 10 Second (10~300)
] Send Email
> Abnormality
V| Snapshot
Storage o2 .
syﬂem, ks " I Default ” Refresh “ Save
Information
TargetFilter @ Max Size o
Min Size ’
Figure 6-74
Step 2
Sel ect AEnabl ed to enable face detection function.
Step 3
Click ADraw Targeto to draw the size model of
Step 4
It is to set the parameters of face detection, please refer to the following sheet for more details.
Parameter Function
Note:

Working Period

It is to set the alarm period, it can enable alarm event only during the period

range which has been set.

1. Click ASetupod and the system wil/]
Periodo.

2. ltis to set working period according to the following methods:

You can input time numerical value or press the left mouse button to

drag on the setup interface to set.

There are six periods to be set every day, select the check box in front

of the period, and then the period is valid.

Select week number (it selects Sunday by default, if it selects the whole

week, then it means the setup can be applied to the whole week, you

can also select the check box in front of the week number to implement

independent setting for some days).

3. CickhSaved to complete the setup o

B

Sel ect AfEnabl e Face Enhancemento a

Enable Face e .
Enhancement clear by priority when the stream is set very low.
Record Check it and so when alarm occurs, system will auto record.

Record Delay

System can delay the record for specified time after alarm ended.

10¢€
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Parameter Function

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended.

Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Snapshot Selecti Snapshoto and the system wil|

alarm occurs.

Step 5
Click ASavedo to complete the setup of face detectioc

6.3.6 People Counting

6.3.6.1 People Counting

Step 1

Select ASetup > Ev e rPeopleCobnéngd | e redystanmill displgy the interface
of AEntrance/ Exi tFigure®Mh5. ch i s shown in

No. Name Rule Type Ll
@ 1 Rule1 People Counting - @

> Video Detection

—Parameter Setup -

> Audio Detection

> Smart Plan -
[v] Enter No.
[v] Leave No.
Storage —
system Sensitivity = O 7
Information Flip Inclined -
Flowrate Alarm
Leave No. 0
Standed No. 0
["] Record
Record Delay 10 s {10~300)
[T Relay-out
Alarm Delay 10 s {10~300)
[C] send Email
[v] Snapshot
| Default I | Refresh I | Save

Figure 6-75

Step 2
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Select AEnabled to enableandexiat i stics function of
Step 3
Click ADraw Ruledo to draw an area in the monitor.i
Step 4
Click ADraw Targeto to draw the size model of fil
Step 5
It is to set the parameters of entrance and exit, please refer to the following sheet for more details.

Parameter Function

0SD Select the Enter No. or Leave No. check box to display the number of the

people that enter or leave this area.

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the period

range which has been set.

1. Click ASetupo and the system wi
Periodo.

2. ltis to set working period according to the following methods:

You can input time numerical value or press the left mouse button to

drag on the setup interface to set.

There are six periods to be set every day, select the check box in front

of the period, and then the period is valid.

Select week number (it selects Sunday by default, if it selects the whole

week, then it means the setup can be applied to the whole week, you

can also select the check box in front of the week number to implement

independent setting for some days).

3. Click ASavedo to complete the se
Sensitivity Con_figure the aIarm sensjtivity, and the bigger the sensitivity value is, the
easier the alarm will be triggered.
Flip Select from the list to rotate the image, and you can select Inclined or

Vertical.

Flowrate Alarm

It is to set the enter number, leave number, stranded number; it will trigger
alarm when it exceeds the limited number.

Record

Check it and so when alarm occurs, system will auto record.

Record Delay

System can delay the record for specified time after alarm ended.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended.

Send Email If you enabled this function, System can sc_and out en_1ai| to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Snapshot Select ASnapshotd and the system w
alarm occurs.

Step 6

Cl

ick ASaved t o cpeoplpdtoenting. the setup of

11C
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6.3.6.2 In Area No.

Step 1

Select ASetup > Event > People Counting >InRPReapl e Cc
No. interface, which is shown in the following figure.

e

No. Name Rule Type CH]
V] 1 Rule1 In Area No. - e
> Video Detection
> Audio Detection Parameter Setup
0sD

> Smart Plan

[7] Inside Number

> Abnormality -
Storage Sensitivity = 0 7
System Flip Inclined -
Information [V] Regional Number Statistics Al...
Inside Number 30 (0~30)
Type >Threshold v
[7] Stranding Alarm
Stranding Time 30 s (1~1800)
[7] Record
Record Delay 10 s (10~300)
[7] Relay-out
Alarm Delay 10 s {10~300)
[7] Send Email
[¥] Snapshot
| Default | | Refresh I I Save |

Step 2

Sel ect AEnabl ed to enable statistics function of en
Step 3

Click Adad atwo draw an area in the monitoring image.
Step 4

It is to set the parameters of entrance and exit, please refer to the following sheet for more details.

Parameter Function

0SD Sele_ct th_e Inside Number check box to display the number of the people
that in this area.
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Parameter

Function

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the period

range which has been set.

1. Click fASetupo
Periodo.

2. ltis to set working period according to the following methods:

You can input time numerical value or press the left mouse button to

drag on the setup interface to set.

There are six periods to be set every day, select the check box in front

of the period, and then the period is valid.

Select week number (it selects Sunday by default, if it selects the whole

week, then it means the setup can be applied to the whole week, you

can also select the check box in front of the week number to implement

independent setting for some days).

and the system wi

3. Click ASavedo to complete the se
Sensitivity Configure the alarm sensitivity, and the bigger the sensitivity value is, the
easier the alarm will be triggered.
Flip Sele_ct from the list to rotate the image, and you can select Inclined or
Vertical.
Regional Select the check box to enable this fur_1ctior_1, and then d_efine the Inside
Number Number and Type. There are two options in the Type list.

Statistics Alarm

Select OThreshold, and then the alarm will be triggered if the number
of the people.in the area is greater than or equal to the defined number.
Select OThreshold, and then the alarm will be triggered if the number
of the people.in the area is lower than or equal to the defined number.

B

Stranding Alarm

Select the check box to enable this function, and then when people stay in
this area for longer than the defined time period, the alarm will be triggered.

Record

Check it and so when alarm occurs, system will auto record.

Record Delay

System can delay the record for specified time after alarm ended.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.
Alarm Delay System can delay the alarm output for specified time after alarm ended.
Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.
Snapshot Select ASnapshotd and the syst emwhew
alarm occurs.
Step 5
Click ASaveo to complete the setup of peopl e

6.3.6.3 Report
It is to generate a form of report according to the number statistics.
Step 1

count i
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EverPteop | Re Cwlue t € mugn tRierpgdl displayfihe n d

interface of People Counting Report, which is shown in Figure 6-76.

Camera
Network
Event

> Video Detection
> Audio Detection

> Smart Plan

Rule  In Area No. -

Report Type  Daily - Begin Time | 2018-10-23 i 00 00 0o EndTime  2018-10-23 i 16 0o 0o +Daily report max range is 24 hours.

Stranding Time @ 5s 30s 60s ReportType @ Bar Chart Line Chart

. S le Counti —
Figure 6-76
Step 2
It is to set search condition, please refer to the following sheet for more detalils.
Parameter Note
Rule Select the rule you need.
Report Tvpe Can select day report, month report, or year report; also can select bar chart or line
P yp chart to display the report.
Time It can set the begin /end time within the range of statistics time.
Stranding This option displays if you select the In Area No. rule, and you can select the report
Time with the stranding time you need.

Flow Direction

This option displays if you select the People Counting rule, and you can select
enter, leave and display number; the data of checked item can be displayed in the
report.

Report Type You can select from Bar Chart report or Line Chart report.
Search Search flow statistics data according to the setting to form report.
Export Export the saved report.
Step 3
Click ASearcho to compl et eoexperphereportst ati sti cs,

6.3.7 Heat Map

6.3.7.1 Heat Map

It is the density statistics of moving object that can generate report, the color range is from blue to red,
blue means the min heat value and red means the max heat value.

Mirroring, view angle change and heat map original data will be cleared.

Step 1

Sel ect

ASetup >

Event > Heat Map > Heat Mapo

which is shown in Figure 6-76.
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Camera

Network
Enable

> Video Detection ¢ 7 ‘ It
S 1 Working Period

> Audio Detection
> Smart Plan

> Ivs

> Face Detection

e Counting

> Alarm
> Abnormality
Storage
System
Information
Default ” Refresh H Save
Figure 6-76

Step 2

Select AEnabled to enable heat map function.

Step 3

It is to set the working period.

1. Click fiSetupod and the system wil/ di splay the
Figure 6-77.

Working Period X |

0 2 4 6 8 10 12 14 16 18 20 22 24

Sy
Wednesday W

LT e e P P PP P T Selup

Al ¥ sunday I~ Monday I~ Tuesday I Wednesday I~ Thursday I Friday [ Saturday
I Pericd®: | 00 : 00 : 00 |-| 23 : 69 : &9 |
I Period2: | 00 : 00 : 00 | -| 23 . 59 : &9 |
I Pericd3: | 00 : 00 : 00 |-| 23 : 69 : &9 |
I Period4: | 00 : 00 : 00 | -| 23 . 59 : 59 |
I Pericds: | 00 : 00 : 00 |-| 23 : 69 : &9 |
I Pericds: | 00 : 00 : 00 |-| 23 : 69 : &9 |
| sae || cancal
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Figure 6-77

2. ltis to set working period according to the following methods:
. You can input time numerical value or press the left mouse button to drag on the setup interface to
set.

There are six periods to be set every day, select the check box in front of the period, and then the
period is valid.

Select week number (it selects Sunday by default, if it selects the whole week, then it means the
setup can be applied to the whole week, you can also select the check box in front of the week

number to implement independent setting for some days).

3. Click ASaved to complete the setup of working per
Step 4
Click ASavedo to complete the setup of heat map.

6.3.7.2 Report
It is to generate the form of report according to the heat map data.
Step 1

\

Select ASetup > Event > Heat Map > Reporto and the
is shown in Figure 6-78.

@lhua

Camera Heat Map

Network
e Start Time | 2016-05-23 00 EndTime | 2016-05-23 B 16 *Report Max Range Is 1 Week

> Video Detection :]
> Audio Detection
> Smart Plan

> Ivs

> Face Detection
> People Counting

__ HeatMap

> Alarm

> Abnormality
Storage
System

Information

Figure 6-78

Step 2
11E



alhua .
CZW Dahua Network Camera Web 3.0 Operation Manual
Itis to set begin time and end time.

Step 3
Click ASearchd to complete report statisti
6.3.8 Alarm

Please note some series products do not support this function.

5.3.2.1 PIR alarm

The alarm activation interface PIR alarm is shown as in Figure 6-79.

Figure 6-79
Please refer to the following sheet for detailed information.
Parameter Function
Enable After enabled, relay activation will work. Check it and enable the
PIR alarm.
Working . This function becomes activated in the specified periods.
period . There are six periods in one day. Please draw a circle to
enable corresponding period.

., Select date. If you do not select, current setup applies to
today only. You can select all week column to apply to the
whole week.

. Click OK button, system goes back to motion detection
interface; please click save button to exit.

Note: User can set via dragging mouse while not releasing left

mouse.

Anti-dither System only memorizes one event during the anti-dither period.

The value ranges from 0s to 100s.

csS
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